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Notices

Copyright Notice
© Keysight Technologies, 2019-2023

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or
translation into a foreign language) without prior agreement and written consent from Keysight Technologies as
governed by United States and international copyright laws.

Manual Part Number
DAQ97-90000

Edition

Edition 5, December 2023

Published by

Keysight Technologies

Bayan Lepas Free Industrial Zone
11900 Bayan Lepas, Penang
Malaysia

Software Revision

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To
search for software updates and the latest documentation for your product, go to the product page at:

- www.keysight.com/find/DAQ970A
- www.keysight.com/find/DAQ973A

A portion of the software in this product is licensed under terms of the General Public License Version 2 (GPLv2). The
text of the license and source code can be found at www.keysight.com/find/GPLV2.

This product uses Microsoft Windows CE. Keysight highly recommends that all Windows-based computers
connected to Windows CE instruments use current anti-virus software. For more information, go to the respective
product page at:

- www.keysight.com/find/DAQ970A
- www.keysight.com/find/DAQ973A
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Notices

Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED "AS IS", AND IS SUBJECT TO BEING CHANGED,
WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, WITH REGARD TO THIS MANUAL
AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS
OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT OR OF ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND
THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN
THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT
SHALL CONTROL.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied
only in accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered
and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or as a
"commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR 52.227-19
(June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is
subject to Keysight Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of
the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c) (1-2) (June
1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987)
or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Waste Electrical and Electronic Equipment (WEEE)

This product complies with the European WEEE directive marketing requirement. The affixed product label (see
below) indicates that you must not discard this electrical/electronic product in domestic household waste.

Product Category: With reference to the equipment types in the European WEEE directive Annex 1, this product is
classified as "Monitoring and Control instrumentation" product. Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more information.
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Notices

Declarations of Conformity

Declarations of Conformity for this product and for other Keysight products may be downloaded from the Web. Go
to https://regulations.about.keysight.com/DoC/default.htm, you can then search by product model number to find

the latest Declaration of Conformity.
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Safety and Regulatory Information

Safety Considerations

The following general safety precautions must be observed during all phases of operation, service, and repair of this
instrument. Failure to comply with these precautions or with specific warnings elsewhere in this manual violates
safety standards of design, manufacture, intended use of the instrument, and could result in electrical shock or
injury. Keysight Technologies assumes no liability for the customer's failure to comply with these requirements.

m BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the unit before applying power.

GROUND THE INSTRUMENT

This product is provided with protective earth terminals. To minimize shock hazard, the instrument must be
connected to the ac power mains through a grounded power cable, with the ground wire family connected to
an electrical ground (safety ground) at the protective (grounding) conductor. Disconnection of the protective
earth terminal will cause a potential shock hazard that could result in personal injury.

BEFORE POWER ON AND OFF
Before powering on the instrument, make sure all signal sources connected to modules are turned off. Turn on

signal sources after the instrument is powered on. Turn off signal sources before the instrument is powered
off.

DO NOT REMOVE THE INSTRUMENT COVER
Only qualified, service-trained personnel who are aware of the hazards involved should remove the instrument
covers. Always disconnect the power cable and any external circuits before removing the instrument cover.

MODULE COVERS
Always replace module covers after terminal wiring and before inserting into mainframe.

DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE
Do not operate the instrument in the presence of flammable gases or fumes.

DO NOT MODIFY THE INSTRUMENT
Do not install substitute parts or perform any unauthorized modification to the product. Return the product to
a Keysight Sales and Service Office for service and repair to ensure that safety features are maintained.

DO NOT MEASURE MORE THAN THE RATED VOLTAGE

Maximum voltage as marked on each module is as below:

a) DAQM900A: 120 Vrms

b) DAQM901A, DAQM902A, DAQM903A, DAQMI04A, DAQMI08A: 300 Vrms
c) DAQM905A, DAQMI07A: 42 Vpk

d) DAQM909A: +/-18Vpk (single ended) for both Hl and LO pins.

DO NOT CONNECT ANY MODULE CHANNELS TO MAINS
Measurement category of the instrument is rated as CAT 'Others', terminals should not be directly connected
to the mains.

Keysight DAQ970A/DAQ973A User's Guide 9



Safety and Regulatory Information

AC POWER CORD

Removal of the AC power cord is the disconnect method to remove power from the instrument. Be sure to
allow for adequate access to the power cord to permit disconnection from AC power. Use only the Keysight
specified power cord for the country of use or one with equivalent ratings.

SELF-TEST

Before measuring any hazardous voltage or current, run the *TST? query from the remote interface, and read
the result to verify that the instrument is performing properly. The *TST? query is a self-test that returns +0 if
the instrument passes and +1 if the instrument fails. You can also perform this query from the front panel by
pressing [Utility] > Self Test > Quick Test. If this self-test fails, make sure that the instrument is repaired and
passes the self-test before continuing.

USE THE DEVICE AS SPECIFIED
If the device is used in a manner not specified by manufacturer, the device protection may be impaired.

This is a sensitive measurement apparatus by design and may have some performance loss when exposed to
ambient continuous electromagnetic phenomenon. Measurement Considerations - use shielded or twisted
cable, use common mode choke, ferrite clamp and damping resistor before the input to DAQ970A/DAQ973A.

CLEANING

To prevent electrical shock, disconnect the instrument from AC mains power before cleaning. Clean the out-
side of the instrument with a soft, lint-free, slightly dampened cloth. Do not use detergent, volatile liquids, or
chemical solvents. Do not attempt to clean internally. If needed, contact a Keysight Technologies Sales and
Service Office to arrange for proper cleaning to ensure that safety features and performance are maintained.

NOTE Connect USB cable with ferrite core to the rear panel USB port of the instrument.

Safety Symbol and Regulatory Markings
T

Alternating current (AC).

Protective earth (ground) terminal.

Earth (ground) terminal.

Caution, risk of danger (refer to the manual for specific Warning or Caution information).

Frame or chassis (ground) terminal.

B} +-® ¢

Instrument cable lock.
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Safety and Regulatory Information

This product is marked with the ACMA RCM mark for compliance in Australia/New Zealand. A copy of the
Manufacturer's Australia Declaration of Conformity for this instrument can be obtained by contacting your local
Keysight Technologies Sales Representative.

This symbol indicates the time period during which no hazardous or toxic substance elements are expected to leak
40 or deteriorate during normal use. Forty years is the expected useful life of the product.

indicates the instrument is certified to the applicable Canadian and United States of America standards respect-

SB ® The CSA mark is a registered trademark of the Canadian Standards Association, with the 'C' and 'US' subscript
c Uus ively.

c "fggfgaﬂlf:l‘_’x" The CE mark is a registered trademark of the European Community. This CE mark shows that the product complies

with all the relevant European Legal Directives.

ICES/NMB-001 - This ISM device complies with the Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-007 du Canada.

ISM GRP 1-A - This is an Industrial Scientific and Medical (ISM) Group 1 Class A product.

[@ This symbol is a South Korean Class A EMC Declaration, with the product identification code
"R-REM-Kst-GM16412".

R-REM- R - Identification of authorization prefix.

Kst-GM16412

REM - Identification of basic certification information.

Kst - Identification of applicant's information

GM16412 - Product identification.

Thisis a Class A instrument suitable for professional use and in electromagnetic environment outside of the home.

m The WARNING sign denotes a hazard. It calls attention to a procedure, practice, or the like, which, if not correctly
performed or adhered to, could result in personal injury. Do not proceed beyond a WARNING sign until the indic-
ated conditions are fully understood and met.

The CAUTION sign denotes a hazard. It calls attention to an operating procedure, or the like, which, if not correctly
performed or adhered to, could result in damage to or destruction of part or all of the product. Do not proceed bey-
ond CAUTION sign until the indicated conditions are fully understood and met.

NOTE The NOTE sign denaotes important information. It calls attention to a procedure, practice, condition or the like,
which is essential to highlight. Safety and Regulatory Information 12

South Korean Class A EMC Declaration

Information to the user:

This instrument has been conformity assessed for used in business environments. In a residential environment this
equipment may caused radio interference.

This EMC statement applies to the equipment only for use in business environment.

I cEFERIHUMAEL T HR R JEIINEL 272N NEEHZEUHMAE
sted o ZddeeatAs L
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Safety and Regulatory Information

Product Regulatory and Compliance
The DAQ970A/DAQ973A complies with safety and EMC requirements.

Refer to Declaration of Conformity at http://www.keysight.com/go/conformity for the latest revision.

Maximum transients on all inputs are limited to 1500 Vpk referenced to earth except for DAQM900A,
DAQM905A, DAQM907A and DAQM909A which are 0 Vpk. Measurement is rated for CAT ‘none’, and terminals
are not to be connected directly to mains. Do not use this equipment to measure circuits where transient over-
voltages could exceed this level.

Environmental Conditions and General Characteristics

Keysight DAQ970A/DAQ9I73A is designed for indoor use and in an area with low condensation. Tables below show
the general environmental requirements and general characteristics for this instrument.

Environmental condition Requirement
Temperature Operating condition: 0 °C to 55 °C
Storage condition: =40 °C to 70 °C
Humidity Operating condition: Up to 80% RH at 40 °C (non-condensing), decreasing linearly to 50% RH at 55

°C (non-condensing)
Storage condition: Up to 50% RH at 55 °C (non-condensing)

Altitude Up to 3000m

Pollution degree 2

The electrical (power) requirements of the DAQ970A/DAQ973A are summarized as below.

General characteristics Requirement

Power supply 100 - 240 VAC (Mains supply voltage fluctuation is not allowed to exceed + 10%)
Power line frequency 50/60/400 Hz
Power consumption 75 VA Max

Installation category Il

T:TTTIYe3 DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE OR WET ENVIRONMENTS
Do not operate the instrument around flammable gases or fumes, vapor, or wet environments.
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1T Introduction to the Instrument

Instrument at a Glance

The DAQ970A/DAQR973A combines precision measurement capability with flexible signal connections for your
production and development test systems. Three module slots are built into the rear of the instrument to accept any
combination of data acquisition or switching modules. The combination of USB data logging and data acquisition
features make this instrument a versatile solution for your testing requirements now and in the future.

Easily display, save, and document your measurement results

High usability with an intuitive, menu driven user interface.
Histogram, trend chart, meter and numeric views on a high-resolution color display.
Supported on both LAN and USB interfaces.

Drag and drop, driverless USB connectivity.

Convenient data logging features

Direct measurement of temperature (thermocouples, RTDs, and thermistors), strain, DC voltage, AC voltage,
2-wire and 4-wire resistance, frequency, period, diode, capacitance, DC current, and AC current.

Patented, metrology-level performance that serves as the foundation for all measurements.
Interval scanning with storage of up to 1,000,000 time-stamped readings.

Independent channel configuration with function, measurement scaling, and alarm limits available on a per-
channel basis.

Intuitive user interface with knob cursor navigation keypad, data entry from both softkeys (menu keys inside
the screen view) and hardkeys (menu keys in front of the instrument).

Portable, rugged case with non-skid feet.

BenchVue Data Acquisition (DAQ) software for Microsoft ® Windows ® available for download from www.key-
sight.com/find/benchvue.

Flexible data acquisition/ switching features

Up to 60 channels per instrument (120 single-ended channels).

Reading rates are more than 5,000 readings per second on a single channel and scan rates up to 450 chan-
nels per second.

Choice of multiplexing, matrix, general-purpose Form C switching, RF switching, digital I/O, totalize, DAC
output, and DAC readback functions.

Built-in Web Interface for monitoring and controlling the instrument via a Web browser.

Programming language

14

Compatible with SCPI (Standard Commands for Programmable Instruments) programming language.
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1 Introduction to the Instrument

Front Panel at a Glance

KEYSIGHT DAQ973A DataAcquisition System

. Scan
Trend Stant

101 Digitizer Channel

m View

— Configure —

Channel Interval

25 857
Copy
Dizplay Measure Wertical & Pan & £ % All
Settings | Cursors Zoom Lrats Detail Utility

Trend
2 @
L]

Save
Reesll

Label Description

1 USB Port

2 On/Standby switch with LED indicator

3 Display

4 Softkeys

5 Measurement operation menu (to control the initiation of the measurements)
6 Measurement configuration menu (to set parameters for measurements)

7 Knob

8 Cursor navigation keypad

Front panel key

Press the key to return the instrument into local control when the instrument is in remote

Local

(indicated by the annunciator).
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1 Introduction to the Instrument

Instrument Annunciators

The table below shows the various annunciators that are available on the DAQ970A/DAQ973A. The annunciators will
be shown on the top of the display when the corresponding conditions are met.

Annunciator Description

Monitor mode enabled.

Digitizing is in progress.

Scanning/DMM digitizing is in progress.

A - Alarms are present in the alarm queue.
H1234L - AHigh or Low alarm condition has occurred.

Internal DMM is disabled. Instrument configured for an external scan interval when DMM is Off.

Reading memory overflowed at 1,000,000 readings. New readings will averwrite the oldest readings.

A USB drive is inserted in the front panel USB host port.

Instrument is in remote (remote interface)

EEIIII“‘H

Errors are present in the error queue. Press [View] > Errors to view the list of errors.
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1 Introduction to the Instrument

Rear Panel at a Glance

KEYSIGHT DpAQM909A
4 Channel, 24-bit
Digitizer Moadule

Label Description

1 Slot identifier (100, 200, 300)

GPIB interface (Available on the DAQ973A only)

AC mains input

LAN interface connector

USB interface connector

External trigger input, alarm outputs, channel advance input, and channel close output

~N| OO o BN

Chassis ground screw
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1T Introduction to the Instrument

Plug-In Modules at a Glance

The DAQ970A/DAQI73A offers a complete selection of plug-in modules to provide a high quality measurement,
switching, and control capabilities. For more details, see Module Overview.

Supported modules on the DAQ970A/DARY73A:
- DAQM900A 20-Channel FET Multiplexer Module
- DAQM90TA 20-Channel Armature Multiplexer Module
- DAQM902A 16-Channel Reed Multiplexer Module
- DAQM903A 20-Channel Actuator/General-Purpose Switch Module
- DAQM904A 4x8 Two-Wire Matrix Switch Module
- DAQMO905A Dual 1:4 RF Multiplexer (50 Q) Module
- DAQM907A Multifunction Module
- DAQMI08A 40-Channel Single-Ended Multiplexer Module
- DAQM909A 4-Channel 24-Bit Digitizer Module

NOTE Refer to the product data sheet at http://literature.cdn.keysight.com/litweb/pdf/5992-3168EN.pdf for a
complete specifications on all the supported modules.

18 Keysight DAQ970A/DAQ973A User's Guide


http://literature.cdn.keysight.com/litweb/pdf/5992-3168EN.pdf

1 Introduction to the Instrument

Dimension Diagram

Bench dimension:
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1 Introduction to the Instrument

Remote Interface Configuration

IVIYI[el REMOTE OPERATION

When any channel is connected to a hazardous voltage source, the instrument and the device under test
should be supervised, following local EHS practices to restrict access.

NOTE If Secure mode is enabled, the instrument must be unlocked with the correct security code to perform many of
these actions. See Security for more information.

The DAQ970A supports remote interface communication over LAN and USB interfaces. The DAQ973A however
supports an additional GPIB interface on top of LAN and USB interface. All the interfaces are "live" at power up when
the instrument ships from the factory.

- LAN Interface: By default, the DHCP (Dynamic Host Configuration Protocol) is on, a protocol for assigning
dynamic IP addresses to network devices, which may enable communication over LAN. With dynamic
addressing, a device can have a different IP address every time it connects to the network. See LAN Settings
for more information.

- USB Interface: Use the rear panel USB interface connector to communicate with the instrument using your
PC. See USB Settings for more information.

- GPIB Interface (DAQ973A only): Set the instrument's GPIB address and connect to your PC using a GPIB
cable.

Keysight IO Libraries Suite

NOTE Ensure that the Keysight IO Libraries Suite is installed before you proceed for the remote interface con-
figuration.

Keysight 10 Libraries Suite is a collection of free instrument control software that automatically discovers
instruments and allows you to control instruments over LAN and USB interfaces. For more information, or to
download the IO Libraries, go to www.keysight.com/find/iosuite.

GPIB Settings (DAQ973A only)

Each device on the GPIB (IEEE-488) interface must have a unigue whole number address between 0 and 30. The
instrument ships with a default address of 9, and the GPIB address is displayed at power-on.

This setting is non-volatile; it will not be changed by power cycling or *RST or SYSTem:PRESet. Your computer’s
GPIB interface card address must not conflict with any instrument on the interface bus.

Front panel Remote interface

Press [Home] > User Settings > I/0 > GPIB. SYSTem:COMMunicate:GPIB:ADDRess <address>
From this menu, you can set the GPIB address and turn SYSTem:COMMunicate:ENABLe {ON|1|OFF|0},GPIB
GPIB on or off. After making changes, you must cycle

power on the instrument for the change to take effect.
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1 Introduction to the Instrument

LAN Settings

The following sections describe the primary front panel LAN configuration functions, including SCPI commands
where applicable. In the DAQ970A/DAQ973A Programming Guide, see "SYSTem Subsystem - Remote Interface
Configuration Commands" for all LAN configuration commands.

NOTE Some LAN settings require you to cycle power to activate them. The instrument briefly displays a message
when this is the case. Observe the display closely as you change the LAN settings.

Enable or disable LAN interface

Front panel Remote interface
Press [Home] > User Settings > I/0 > LAN SYSTem:COMMunicate:ENABLe {OFF | ONJ, LAN
Set the softkey to On or Off

View the LAN status, MAC status, and current LAN configuration settings

Once the LAN interface is enabled, you can view the LAN status, MAC address, and current LAN configuration
settings from the front panel. The LAN status may be different from the front panel configuration menu settings,
which depends on the network configuration. If the settings are different, it is because the network has automatically
assigned its own settings. If the instrument goes into remote, all LAN changes will be disabled and the display will go
into a different screen. Re-selecting with LAN Settings page will display the new settings if a LAN restart took place.

Press [Home] > User Settings > I/0 > LAN Settings (none)
Modify Settings

As shipped from the factory, the instrument pre-configured settings (DHCP is on) should work in most LAN
environments. However, if you wish to manually set an IP address, Subnet Mask, or Default Gatewway, turn DHCP
off, then change the IP setup as described below.

Manual/DHCP

The DHCP can automatically assign a dynamic IP address to a LAN device. This is typically the easiest way to
configure the instrument for LAN. This setting is non-volatile, it will not be changed by cycling power, factory reset
(*RST command), or instrument preset (SYSTem:PRESet command).

Disabling DHCP will enable the Manual setting, and vice versa.

Front panel Remote interface
Press [Home] > User Settings > I/0 > LAN Settings > SYSTem:COMMunicate:LAN:DHCP {OFF|ON}
Modify Settings.
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To

Introduction to the Instrument

enable DHCP:

Manual / DHCP MAC Address:

LAN Status:
Gateway:
DNS Sec Addr:
WINS Sec Addr:
K-DAQS704-0010
mDNS Service: Keysight DAGIT0A Data Acquisition System
mDNS Hostname: K-DAQS70A-0010.local
Domain Name:
IPv6 Local Addr:
IPv6 Global Addr:

IP Address:
Subnet Mask:
DNS Prim Addr:
WINS Prim Addr:
DNS Hosthame:

Good

Modify
Settings

LAN
Services

Setto
Defaults

Step Front panel Remote interface

1 Press [Home] > User Settings > /0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:DHCP ON
Set the first softkey to DHCP.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

To disable DHCP:

MAC Address:
(GERGEUEROE  LAN Status:

Gateway:
DNS Sec Addr:
WINS Sec Addr:

Manual / DHCP

IP Address:
Subnet Mask:
DNS Prim Addr:
WINS Prim Addr:
DNS Hostname: K-DaQA4704-0010

mDNS Service: Keysight DAQST04A Data Acquisition System
mDNS Hostname: K-DAQS704-0010local

Domain Name:

IPv6 Local Addr:

IPv6 Global Addr:

80090201F0RB

Good

Host
Name

IP
Address

Subnet
Mask

EGIEL
DHCP

Step  Front panel

Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings.
Set the first softkey to Manual.

Remote interface
SYSTem:COMMunicate:LAN:DHCP OFF

If you change this parameter, you must press
[Done] > [Apply Changes] for the change to take effect.

SYSTem:COMMunicate:LAN:UPDate
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1 Introduction to the Instrument

Once DHCP is disabled, the following parameters will be available for manual setup:
- Host Name
- IP Address
- Subnet Mask
- Gateway
- Primary and Secondary DNS
= Primary and Secondary WINS

— Service mDNS

Host Name

A hostname is the host portion of the domain name, which is translated into an IP address.

Step  Front panel Remote interface

1 Press [Home] > User Settings > /0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:HOSTname
Set the first softkey to Manual and press Host Name to enter the host name.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Done] > [Apply Changes] for the change to take effect.

Each instrument is shipped with a default host name with the format: K-modelnumber-serialnumber, where
modelnumber is the instrument’s 7-character model number (e.g. DAQ970A), and serialnumber is the last five
characters of the 10-character instrument serial number located on the label on the top of the unit (e.g. 45678 if the
serial number is MY12345678).

Manual / DHCP MAC Address: B0

Host Name

[§-DAQY70A-5678

Clear Delete Next
All Char ' Char || Cancel || Done

- The instrument receives a unique hostname at the factory, but you may change it. The hostname must be
unique on the LAN.

- The name must start with letter, other characters can be an upper or lower case letters, numeric digits, or
dashes "-".

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).
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1 Introduction to the Instrument

I[P Address

You can enter a static IP address for the instrument as a four-byte integer expressed in dot notation. Each byte is a
decimal value, with no leading zeros (for example, 169.254.2.20). Refer to More about IP Addresses and Dot

Notation for further details.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:IPADdress
Set the first softkey to Manual and press |P Address to set the desired
IP address.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate

[Done] > [Apply Changes] for the change to take effect.

- IfDHCPis on, it attempts to assign an IP address to the instrument. If it fails, Auto-IP attempts to assign an IP
address to the instrument.

- Contact your LAN administrator to obtain an IP address.

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).

Subnet Mask

Subnetting allows the LAN administrator to subdivide a network to simplify administration and minimize network
traffic. The subnet mask indicates the portion of the host address used to indicate the subnet.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:SMASk
Set the first softkey to Manual and press Subnet Mask to set the desired
subnet mask address.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

- Contact your LAN administrator to obtain an IP address.

- This setting is non-volatile, it will not be changed by cycling power, factory reset (RST command), or instru-
ment present (SYSTem:PRESet command).
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1 Introduction to the Instrument

Gateway

A gateway is a network device that connects networks. The default gateway setting is the IP address of the
instrument.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:GATEway
Set the first softkey to Manual and press Gateway to set the desired
gateway address.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate

[Done] > [Apply Changes] for the change to take effect.

- Do not set a gateway address when DHCP is enabled (factory default).
- Contact your LAN administrator to obtain an IP address.

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).

Primary and Secondary DNS

A DNS (Domain Name Service) is an Internet service that translates domain names into IP addresses. The DNS
server address is the IP address of a server that performs this service.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:DNS[{1]2}]
Set the first softkey to Manual and press Primary DNS or Second DNS

Note: The [{1]2 tax indicates the type of pri
to set the desired DNS address. ote: The [{112}] syntax indicates the type of primary

(1) or secondary (2) DNS server address.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

- Normally, DHCP discovers the DNS address information; you only need to change this if DHCP is unused or non-
functional.

— Contact your LAN administrator to obtain an IP address.

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).

Keysight DAQ970A/DAQ973A User's Guide 25



1 Introduction to the Instrument

Primary and Secondary WINS

AWINS (Windows Internet Name System) is a system that enables Windows to identify NetBIOS systems on a
TCP/IP network.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. SYSTem:COMMunicate:LAN:WINS[{1]2}]
Set the first softkey to Manual and press Primary WINS or Second WINS

Note: The [{1]2 tax indicates the t fpri
to set the desired WINS address. ote: The [{1|2}] syntax indicates the type of primary

(1) and secondary (2) WINS server address.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

= Normally, DHCP discovers the WINS address information; you only need to change this if DHCP is unused or
nonfunctional.

- Contact your LAN administrator to obtain an IP address.

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).

Service mDNS

A mDNS (multicast Domain Name Service) is an Internet service that is registered with the selected naming service.

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > Modify Settings. LXI:MDNS:SNAMe:DESired
Set the first softkey to Manual and press Service mDNS on the third page
of the menu to set the desired mDNS service name.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

Each instrument is shipped with a default service name with the format:
Keysight Technologies_<modelNumber>_- serial

Number where modelNumber is the instrument 7-character model number (DAQ970A) and product name (Data
Acquisition System), and serialNumber is the last five characters of the 10-character instrument serial number
located on the label on top of the unit (e.g. 45678 if the serial number is MY12345678).

— The instrument receives a unique mDNS service name at the factory, but you may change it. The mDNS service
name must be unique on the LAN.

- The name must start with letter, other characters can be an upper or lower case letters, numeric digits, or
dashes "-".

- This setting is non-volatile, it will not be changed by cycling power, factory reset (*RST command), or instru-
ment present (SYSTem:PRESet command).

26 Keysight DAQ970A/DAQ973A User's Guide



1 Introduction to the Instrument

LAN Restart

Any modification on the LAN settings described above will restart the LAN after pressing Apply Changes. This feature
restarts the networking using ALL current LAN settings. LAN restart does not clear the Web Interface password.

Remote interface
LXI:REStart

LAN Services

Enables (On) or disables (Off) LAN services on the instrument.

VXI-11 Sockets Telnet
Off On 0ff On Off On

mDNS HiSLIP Done More

Off On Off On 2ot

Step  Front panel Remote interface

1 Press [Home] > User Settings > I/0 > LAN Settings > LAN Services (none)
Press On to enable or Off to disable each setting.

2 If you change this parameter, you must press SYSTem:COMMunicate:LAN:UPDate
[Done] > [Apply Changes] for the change to take effect.

— Refer to the Keysight IO Libraries help for information on the VXI-11, Sockets, and HiSLIP protocols.

— Telnet - The instrument telnet port is 5024. Open SCPI sessions on the Telnet connection by entering: telnet IP
address 5024

- Web - Enable or disable instrument programming from the instrument's Web Interface.

- mDNS - mDNS service is for use in networks where no conventional DNS server is installed. Cycling power or
resetting the LAN always enables mDNS.

Set to Defaults

This feature resets the LAN settings to the respective factory default values.

Press [Home] > User Settings > I/0 > LAN Settings > Set to (None)
Defaults
LAN Reset

Resets the LAN using its current settings and enables DHCP mode and mDNS service. The LAN reset also clears any
user-defined Web user interface (Web Ul) password.

Front panel Remote interface

Press [Home] > User Settings > I/0 > LAN Reset LXI:RESet
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1T Introduction to the Instrument

Web Interface

The DAQ970A/DAR973A includes a built-in Web Interface for remote instrument access and control over LAN via a
Web browser. Further details, refer to Web Interface.

More about IP Addresses and Dot Notation

Dot-notation addresses ("nnn.nnn.nnn.nnn" where "nnn" is a byte value from 0 to 255) must be expressed with care,
as most PC web software interprets byte values with leading zeros as octal (base 8) numbers. For example,
"192.168.020.011" is actually equivalent to decimal "192.168.16.9" due to ".020" is interpreted as "16" expressed in
octal,and ".011" as "9". To avoid confusion, use only decimal values from O to 255, with no leading zeros.
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1 Introduction to the Instrument

USB Settings

USB Settings configures the front panel USB (storage) and rear panel USB (connectivity) connectors

USB SCPI File Access [ Show

Off On Off On | USBID
Front panel Remote interface
Press [Home] > User Settings > I/0 > USB Settings SYSTem:COMMunicate:ENABLe {OFF | ON}, USB
USB SCPI

USB SCPI enables (On) or disables (Off) the instrument's USB control port on the rear panel. Once the interface state
is changed, you must cycle the instrument power for the change to take effect. When disabled, the interface cannot
be configured in the Keysight 10 Libraries Connection Expert utility.

Easy File Access (File Access Softkey)

Easy File Access allows you to easily transfer files between the instrument and your PC. Simply connect the rear
panel USB control port on the instrument to a USB port on your PC and then use the window that appears on your
PC to copy files from the instrument to your PC.

al M = | Internal Storage - O X
Home Share View o
- v N am <« Keysi.. » Internal Storage v O Search Internal Storage P
A

# Quick access FOLDER 1
‘@& OneDrive

[. DATA1

B This PC 4‘ Microsoft Excel Comma Separate...
o . a 0 bytes

[ Desktop

= Iy STATELO

5| Documents STA File

12.7KB

A

& Dow

Keysight DAQ970A Data Acquisition System

== Internal Storage
J‘l Music
(=] Pictures

B Vvideos

=, 0SDisk (C:) v

3 items

m

You can use your PC's standard file management features to copy files from the instrument to your PC.
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1 Introduction to the Instrument

NOTE To use Easy File Access at the same time that you are remotely programming the instrument with SCPI over
the USB interface (USB SCPI), you must have Keysight |0 Libraries Suite 16.3 or later installed on your PC. You
may download the latest version at www.keysight.com/find/iosuite.

To use Easy File Access on a PC running the Windows XP operating system, make sure you have Microsoft Win-
dows Media Player 11 for Windows XP SP1, or are using a Microsoft Windows XP SP2, SP3, or a newer

version of Windows. You may download this software at
www.microsoft.com/en-us/-download/details.aspx?id=8163.

Show USB ID

Displays the USB address string as used in VISA programming applications

Technical Connection Details

In most cases, you can easily connect to the instrument with the 10 Libraries Suite or Web interface. In certain
circumstances, it may be helpful to know the following information.

Interface Details

LAN VISA String: TCPIPO::<IP Address>::inst0::INSTR
Example: TCPIP0::192.168.10.2::inst0::INSTR
Web Interface Port number 80, URL http://<IP address>/
USB USB ID is in the form of USBO::<Vendor ID>::<Prod ID>::<Serial Number>::0::INSTR

Example: USBO::0x2A8D::0x0902::MY55160003::0::INSTR
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1 Introduction to the Instrument

LAN Configuration Procedure

There are several parameters that you might need to set to establish network communication using the LAN
interface. Primarily, you will need to establish an IP address. You might need to contact your network administrator
for help in establishing communication with the LAN interface.

If Secure mode is enabled, the instrument must be unlocked with the correct security code to perform many of

NOTE
o these actions. See Security for more information.

1. Press[Home] > User Settings > I/0 > LAN Settings.

2. You can select Modify Settings to change the LAN settings, select LAN Services to enable (On) or disable (Off)

LAN services on the instrument, or select Set to Defaults to restore the LAN settings to its factory default
settings.

Manual / DHCP MAC Address:

IP Address: LAN Status: Good
Subnet Mask: Gateway:

DNS Prim Addr: DNS Sec Addr:

WINS Prim Addr: WINS Sec Addr:

DNMS Hostname: K-D&AQS704-0010

mDMNS Service: Keysight DAGATF0A Data Acquisition System

mDNS Hostname: K-DAQS70A-0010.local
Domain Name:

IPv6 Local Addr:

IPvb Global Addr:

Modify LAN Set to
Settings Services | Defaults

3. To change settings, press Modify Settings. To access most items on this screen, use the first softkey to switch
from DHCP to Manual. With DHCP on, an IP address will automatically be set by the DHCP (Dynamic Host Con-
figuration Protocol) when you connect the instrument to the network; provided that the DHCP server is found
and is able to do so. The DHCP also automatically deals with the subnet mask, gateway address, DNS, WINS,
and domain name, if required. This is typically the easiest way to establish LAN communication for your instru-
ment; all you need to do is leave the DHCP on. Contact your LAN administrator for details.

4. Establish an "IP Setup"
If you are not using DHCP (the first softkey is set to Manual), you must establish an IP setup, including an IP

address, and possibly a subnet mask and gateway address. The IP Address and Subnet Mask softkeys are on the
main screen. Press More to configure other settings.

Contact your network administrator for the IP address, subnet mask, and gateway to use. All IP addresses take

the dot-notation form "nnn.nnn.nnn.nnn" where "nnn" in each case is a byte value in the range 0 through 255.
You can enter a new IP address using the knob or the front panel arrow keys. Do not enter leading zeros.
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Configure the "DNS Setup" (optional)
The DNS (Domain Name Service) is an Internet service that translates domain names into IP addresses. Ask

your network administrator whether the DNS is in use, and if it is, for the host name, domain name, and DNS
server address to use.

a. Setthe "hostname". Press Host Name and enter the hostname. A hostname is the host portion of the
domain name, which is translated into an IP address. The hostname is entered as a string using the front
panel arrow keys to select and change characters. The hostname may include letters, numbers, and dashes

(II_II).

b. Setthe "DNS Server" addresses. From the LAN configuration screen, press More to go to the second of
three sets of softkeys.

Enter the Primary DNS and Second DNS. See your network administrator for details.
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1 Introduction to the Instrument

Firmware Update

Do not turn off the instrument during the update.

1. Press[Home] > Help > About to determine the firmware revision that is currently installed.

2. Go to www.keysight.com/find/DAQ970Afirmware to find the latest firmware revision. If this matches the revision
installed on your instrument, there is no need to continue with this procedure. Otherwise, download the firm-
ware update utility and a ZIP file of the firmware. Detailed firmware instructions are in the Firmware Update Util-
ity Instructions located on the download page.

3. Unzip the ZIP file and use the firmware update utility to prepare a USB drive with the updated firmware.

4. Attach the USB drive to the instrument front panel and press [Utility] > Admin > Firmware Update to update the
firmware. If Secure mode is enabled, unlock the instrument with the security code before installing
firmware.

Important: In order to update the instrument firmware from remote, the model number in the *IDN? response must
match the actual instrument model number. If you have changed the instrument's *IDN? response to another
instrument, when attempting to update the firmware from remote, you will see this error: "The instrument is not
supported by this firmware file". To update the firmware, either update using the front panel procedure or, from
remote, use SYSTem:PERSona:MODel to set the *IDN? to match the actual model number, update the firmware, and
then use SYSTem:PERSona:MODel again to set the *IDN? response to the other model number.
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Contacting Keysight Technologies

You can contact Keysight Technologies for warranty, service, or technical support.
In the United States: (800) 829-4444

In Europe: 31 20 547 2111

In Japan: 0120-421-345

Use www.keysight.com/find/assist to contact Keysight worldwide, or contact your Keysight Technologies
representative.
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2 Quick Start

Prepare Instrument for Use

Verify that you received the following items. If anything is missing, please contact your nearest Keysight sales office
or Keysight authorized reseller.

Power cord (for country of destination)
Certificate of calibration (optional)
Supplemental documentation packet

USB 2.0 cable

The Keysight BenchVue Data Acquisition (DAQ) Software can be downloaded from
www.keysight.com/find/benchvue.

Any plug-in modules that you ordered are delivered in a separate shipping container.
An additional cable kit (50 Q) is also included when you order the DAQM905A Dual 1:4 RF Multiplexer (50 Q) Module.

The latest product documentation is available at:

- www.keysight.com/find/DAQ970A
- www.keysight.com/find/DAQ973A
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2 Quick Start

Module Wiring Connection and Installation

m To prevent electrical shock, use only wires that are rated for the maximum voltage applied to any channel.

Before removing a module cover, turn off all power to external devices that are connected to the module.

When any channel is connected to a hazardous voltage source, all channels in the module should be treated as
hazardous.

When any channel is connected to a hazardous voltage source, all channel wiring in the module should be
rated for the maximum voltage applied.

When any channel is connected to a hazardous voltage source, thermocouples attached to any other channel
on the module shall have insulation rated for the maximum voltage, or have additional insulation added rated
for the maximum voltage, and will be isolated from conductive parts using a thermal compound or tape rated
for the maximum voltage applied.

Do not mount, move or remove any thermocouples when the device under test is connected to a signal source.

When any channel is connected to a hazardous voltage source, the instrument and the device under test
should be supervised, following local EHS practices to restrict access.

During power on, any action to install or uninstall the modules from the rear panel will reboot the instrument.

Installing the Module
To connect wiring to a module and install to the rear panel of the instrument, follow the five steps shown below:

1. Using a flat head screwdriver, push the tab forward and lift up the cover to detach it from the module.
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2 Quick Start

2. Connect the wiring to the screw terminals

Cable Tie Wrap
(optional)

4. Replace the module cover.
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2 Quick Start

5. Install the module in to the instrument (at the rear panel)

Uninstalling the Module

To unplug or replace any modules, push the clip located at the rear left side of the module inwards, and then pull it
out from rear panel.
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2 Quick Start

Connect Power and |/O Cables

To turn on the instrument

Before powering on the instrument, make sure all signal sources are turned off. Turn on signal sources after the
instrument is powered on. Turn off signal sources before the instrument is powered off. Connect the power cord and
LAN or USB cable as desired. Press the On/Standby switch on the front panel. Note that this switch is for standby
purpose only. To disconnect the mains from the instrument, remove the power cord. If the instrument does not turn
on, verify that the power cord is firmly connected.

The table below shows the statuses of the LED color displayed while the instrument is powered-on:

LED color Instrument Status

LED off No AC mains power connected.
LED is amber Instrument is in standby mode with AC mains power still connected
LED is green Instrument is turned on.

Power-on self test

After turning on, the instrument runs a power-on self test and displays a message on how to obtain help, along with
the current IP address.

The front-panel display will light up briefly while the instrument perform its power-on self test, with all measurement

channels turned off. If the power-on self test fails, the error annunciator, ERR IR displayed on the screen. See "SCP!
Error Messages" in the DAQ970A/DAR973A Programming Guide for more information on SCPI error codes and error
messages.

NOTE A complete self-test performs a more extensive set of tests than those performed at power-on. See the
DAQ970A/DAQ973A Service Guide for more information on the instrument complete self-test procedure.

The instrument's default measurement function is DC voltage (DCV), with autoranging enabled.

To turn off the instrument

Press and hold the On/Standby switch for about half a second. This prevents you from accidentally turning off the
instrument by brushing against the power switch.

NOTE If you turn off the instrument by disconnecting the power source (this is not recommended), the instrument
turns on as soon as the power is reconnected. You do need to press the On/Standby switch again.
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2 Quick Start

Use the Built-In Help System

The built-in help system provides context-sensitive help on any front panel key or menu softkey. A list of help topics
is also available to help you learn about the instrument. All messages, context-sensitive help, and help topics appear
in the selected language. The menu softkey labels are not translated.

View the list of help topics

Press [Home] > Help > Help Topics to view the list of help topics. Use the knob or the front panel arrow keys to
highlight the desired topic, and press [Select] to view the help contents.

Highlight the desired topic and press Select.

1 Get HELP on any ke

2 Softkey conventions and tips

3 Instrument annunciators

4 Screen captures

b Home menu and monitoring mode

6 Computed channel

7 Strain measurement and strain offset
8 USB datalogging and data mirroring

9 Autocalibration

10 DAC channels in DAQMS07A multifunction module
11 Download the product documentation
12 Contact Keysight Technical Support

In this example, 1 Get HELP on any key was selected. The following help topic appears on the display:

Get HELP on any key
For help on any front panel key or menu softkey, press and hold
that key.

Press Done to exit the help.
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2 Quick Start

View the help information for a front panel key

Press and hold any front panel key or softkey to get context-sensitive help, such as [Scan]. If the message contains
more information than will fit on the display, use the knob or the front panel arrow keys to load in previous/next

page.

Initiates/stops a scan, or performs a single sweep in manual
trigger mode.

* Press once to initiate a scan

* Press and hold to stop a scan

The key's backlight is turned on wrhile scanning is in progress.

The instrument automatically scans the configured channels in
consecutive order from slot 1 through slot 3. Channels that are not
in the scan list are skipped during the sweep.

Press Done to exit the help.
View the instrument information

Press [Home] > Help > About to view the instrument information such as product serial number, IP address (when
connected to LAN interface), and currently installed firmware revision. Press Done to exit.
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2 Quick Start

Adjust the Carrying Handle

The carrying handle has three positions (as shown below). To adjust the handle position, grasp the sides of the

handle, pull outward, and rotate the handle.
L j

Bench-top viewing positions Carrying position
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2 Quick Start

Rack Mounting the Instrument

You can mount the instrument in a standard 19-inch rack cabinet by ordering the rack mount kit with the part
number provided as below. Instructions and mounting hardware are included with each rack-mounting kit. Any
Keysight System Il instrument of the same size can be rack-mounted beside the DAQ970A/DAQ973A.

To prevent overheating, do not block air flow to or from the instrument.
Allow enough clearance at the rear, sides, and bottom of the instrument to permit adequate internal air flow.

NOTE Remove the carrying handle, and the front and rear rubber bumpers, before rack-mounting the instrument.

Removing the handle and bumpers

To remove the handle, rotate it to the vertical position and pull the ends outward.

Rear (bottom view)

Rack mounting a single instrument

To rack mount a single instrument, order the adapter kit (part number: DAQAT90A or 1CM124A).

oo
o =a (o]
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=l=]
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2 Quick Start

Rack mounting instruments side-by-side

To rack mount two instruments side-by-side, order the lock-link kit (part number: DAQA194A or 34194A) and flange
kit (part number: DAQAT91A or TCM107A). Be sure to use the support rails inside the rack cabinet.
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2 Quick Start

Keysight BenchVue Data Acquisition (DAQ) Software

The Keysight BenchVue Data Acquisition (DAQ) Software is a Windows-based application that makes it easy to use
the instrument with your PC for gathering and analyzing measurements. Use this software to set up your test,
acquire and archive measurement data, and perform real-time display and analysis results of your measurements.
The Keysight BenchVue Data Acquisition (DAQ) Software can be downloaded from
www.keysight.com/find/benchvue.

Application main screen:

) DAQ // DAQO70A J/ SIM::13::INSTR

4 Imstrument Settings  Data Logging Settings g - Graphics Setup | 4 None  Off 3 | Hw Alarm

Data Log
- Measurement Scaling (Mx +
File Name:

Humber Name Function Range More Scale  Functon Gain (M)

Append date n ;
PR o DAQMODOA:20-Channel Solid State Switch

Append time 101
Append Number 103
Data Manager File Name 103

104
Comment Text E

105

106

107

Start Data Logging
Immediately with Start Button

At Specific Time:

On Alarm:

Scan Interval

Min Value

>

BenchVue Data Acquisition (DAQ) Software Licensing

To evaluate a BenchVue application for a free 30-day trial period, go to the BenchVue Application view, click once
on the desired application, and then click on the "Start Trial" button - the trial period is based on the number of
calendar days remaining. After the trial period expires, you will be required to purchase a software license for that
application. Keysight's flexible licensing options allow you to select the license type and license terms that best fit
your software needs. For more information on purchasing and installing a software license, see BenchVue Software
Licensing Options in the Keysight BenchVue Data Acquisition (DAQ) Software Help .
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3 Features and Functions

System Overview

This section provides an overview of a computer-based system and describes the parts of a data acquisition system.

- Data Acquisition System Overview

Signal Routing and Switching

Measurement Input

Control Output

Data Acquisition System Overview

You can use the Keysight DAQ970A/DAR973A as a stand-alone instrument, but there are many applications where
you will want to take advantage of the built-in PC connectivity features. A typical data acquisition system is shown
below:

System Cabling

\
.

. = <

=

\
— Transducers,
mﬂoﬁ Sensors, and
= Events

&

/ _\ e e A S I
\1—1/5 EE%>E = S

Computer and Software Plug-in Modules

The configuration offers the following advantages:

= You can use the DAQ970A/DAQR973A to perform data storage, data reduction, mathematical calculations, and
conversion to engineering units. You can use the PC to provide easy configuration and data
presentation.

- You can remove the analog signals and measurement sensors from the noisy PC environment and
electrically isolate them from both the PC and earth ground.

= You can get asingle PC to monitor multiple instruments and measurement points while performing other PC-
based tasks.
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DAQ970A/DAQ973A logic circuitry

As shown below the logic circuitry for the DAQ970A/DAQ9I73A is divided into two sections: earth-referenced and
floating. These two sections are isolated from each other in order to maintain measurement accuracy and
repeatability. See Noise caused by ground loops for further details on ground loops.

External Trigger
OUTa 29 o .
IN | |
1 I I
Alarms =—| Control Floating ' In[tl?\dnml ’
s Eath |-+ | Logic ' :
v /“‘- | |
LAN Reffrenced " Pyl |
ogic 1 L e
To Computer > Sl Bigital Analog Bus
USB i
o Duc RN
"
"~ AC Powerj Plua.l
Ve o g
2 Slots
// = Optical Isolators L
’/l/ = 3 B

The earth-referenced and floating circuitry communicate with each other via an optically-isolated data link. The
earth-referenced section communicates with the floating section to provide PC connectivity. The
DAQR970A/DAQI73A is shipped with LAN and USB interfaces connectivity.

The earth-referenced section also provides four hardware alarm outputs and external trigger lines. You can use the
alarm output lines to trigger external alarm lights, sirens, or send a TTL-compatible pulse to your control system.

The floating section contains the main system processor and controls all of the basic functionality of the instrument.
This is where the instrument communicates with the plug-in modules, scans the keyboard, controls the front-panel
display, and controls the internal DMM. The floating sections also performs measurement scaling, monitors alarm
conditions, converts transducer measurements to engineering units, time stamps scanned measurements, and
saves data in non-volatile memory.
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Plug-in modules

The DAQ970A/DAQ973A offers a complete selection of plug-in modules to give you high-quality measurement,
switching, and control capabilities. The plug-in modules communicate with the floating logic via the internal isolated
digital bus. The multiplexer modules also connect to the internal DMM via the internal analog bus. Each modules
has its own microprocessor to offload the mainframe processor and minimize backplane communications for faster
throughput. See Module Overview for more information.

Module number Common uses

Measurement input

DAQM9I00A Scanning and direct measurement of temperature, voltage, resistance, frequency, and current (DAQM90TA
DAQMI01A only) by using the internal DMM.
DAQM902A
DAQM9I07A Digital Input, Event Counting.
DAQM9I08A Scanning and direct measurement of temperature, voltage, and resistance by using the internal DMM.
DAQM9I09A Digitizing measurement of voltage and strain by using the on board digitizers.
Signal routing
DAQM900A N/A
DAQM9I0TA Multiplexing of signals to or from external instruments.
DAQM902A N/A
DAQMI04A 32 Crosspoint Matrix Switching.
DAQM9I0bA 50 Q high-frequency applications (<2 GHz).
DAQM908A N/A
Control output
DAQM903A General-purpose switching and control using Form C (SPDT) switches.
DAQM907A Digital Output, Voltage (DAC) Outputs.
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System cabling

The plug-in modules have screw-terminal connectors to make it easy to connect your system cabling. The type of
cabling that you use to connect your signals, transducers, and sensors to the module is critical to measurement
success. Some types of transducers, such as thermocouples, have very specific requirements for the type of cable
that can be used to make connections. Be sure to consider the usage environment when choosing wire gauge and
insulation qualities. Wire insulation typically consists of materials such as PVC or PTFE. Table below lists several
common cable types and describes their typical uses.

NOTE Wiring insulation and usage is described in more detail in System Cabling and Connections.

Cable type Common uses Comments

Thermacouple Extension Wire  Thermocouple measurements. Available in specific thermocouple types. Also available in
shielded cable for added noise immunity.

Twisted Pair, Measurement inputs, voltage outputs, Most common cable for low-frequency measurement

Shielded Twisted Pair switching, counting. inputs. Twisted pair reduces common mode noise.
Shielded-twisted pair provides additional noise immunity.

Shielded Coaxial, VHF signal switching. Most common cable for high-frequency signal routing.

Double-Shielded Coaxial Available in specific impedance values (50 Q or 75 Q).

Provides excellent noise immunity. Double-shielded cable
improves isolation between channels. Requires special

connectors.
Flat Ribbon, Digital Input/Output Often used with mass termination connectors. These
Twisted pair Ribbon cables provide little noise immunity.

Transducers and sensors

Transducers and sensors convert a physical quantity into an electrical quantity. The electrical quantity is measured
and the result is then converted to engineering units. For example, when measuring a thermocouple, the instrument
measures a DC voltage and mathematically converts it to a corresponding temperature in °C, °F, or K.

Measurement Typical transducer types Typical transducer output

Temperature Thermocouple 0mVto80mV
RTD 2-wire or 4-wire resistance from 5 ( to 500 Q
Thermistor 2-wire resistance from 10 Q to TMQ

Pressure Solid State +10DVC

Flow Rotary Type 4mAto 20 mA
Thermal Type

Strain Resistive Elements 4-wire resistance from 10 Q to 70 kO

Events Limit Switches 0VorbVPulse Train

Optical Counters
Rotary Encoder

Digital System Status TTL-compatible Levels
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Alarm limits

The DAQ970A/DAQ9I73A has four alarm outputs which you can configure to alert you when a reading exceeds
specified limits on a channel during a scan. You can assign a high limit, low limit, or both to any configured channel
in the scan list. You can assign multiple channels to any of the four available alarms (numbered 1 through 4). For
example, you can configure the instrument to generate an alarm on Alarm 1 when a limit is exceeded on any of the
channels 103, 205, or 320.

You can also assign alarms to channels on the multifunction module. For example, generate an alarm when a
specific bit pattern or bit pattern change is detected on a digital input channel or when a specific count is reached
on a totalizer channel. With the multifunction module, the channels do not have to be part of the scan list to
generate an alarm.

Signal Routing and Switching

The switching capabilities of the plug-in modules available with the DAQ970A/DAQ973A provide test system
flexibility and expandability. You can use the switching plug-in modules to route signals to and from your test system
or multiplex signals to the internal DMM or external instruments.

Relays are electromechanical devices which are subject to wear-out failure modes. The life of a relay, or the number
of actual operations before failure, is dependent upon how it is used - applied load, switching frequency, and
environment. The DAQ970A/DAR9I73A relay maintenance system automatically counts the cycles of each relay in
the instrument and stores the total count in non-volatile memory on each switch module. Use this feature to track
relay failures and to predict system maintenance requirements.

Switching topologies

Several switching plug-in modules are available with different topologies for various applications:

Switching topologies Plug-in modules

Multiplexer DAQM900A, DAQMI0TA, DAQMI02A, DAQMIO5A, DAQMI0BA
Matrix DAQM904A
Form C (single pole, double throw) DAQM903A

The following sections describe each of these switching topologies.
Multiplexer switching

Multiplexers allow you to connect one of multiple channels to a common channel, one at a time. A simple 4-to-1
multiplexer is shown below. When you combine a multiplexer with a measurement device, like the internal DMM,
you create a scanner. For more information on scanning, see Scanning.

Channel 1

Common >—O/g Channel 2
O Channel 3

@, Channel 4
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Multiplexers are available in several types:

Multiplexer type Common use

One-wire (single-ended) For common LO measurements. For more information, see One-wire (single-ended) multiplexers.
Two-wire For floating measurements. For more information, seeTwo-wire multiplexers.

Four-wire For resistance and RTD measurements. For more information, see Four-wire multiplexers.

RF Signal Very High Frequency (VHF) for switching frequencies up to 2.8 GHz.

For mare information, see RF Signal Multiplexing.

Matrix switching

A matrix switch connects multiple inputs to multiple outputs and therefore offers more switching flexibility than a
multiplexer. Use a matrix for switching low-frequency (less than 10 MHz) signals only. A matrix is arranged in rows
and columns. For example, a simple 3x3 matrix could be used to connect three sources to three test points as shown
below:

©+ Source 1

);»// vy 4
.% J}:{/ /})‘// : ; ource
;}\// /}}\// /1):// o= Source

[o No] [e]e] 00

+ - + — + -
Test 1 Test2 Test3

N
N

Ny

Any one of the signal sources can be connected to any one of the test inputs. Be aware that with a matrix, itis
possible to make sure that dangerous or unwanted conditions are not created by these connections.

Form C (SPDT) switching

The DAQM903A contains 20 Form C switches (also called single-pole, double-throw). You can use Form C switches
to route signals but they are typically used to control external devices.

Channel Open Channel Closed
(NC Contact Connected) (NO Contact Connected)

o— NO NO
NO = Normally Open
NC = Normally Closed >—@ NC o—@ NC
COM COM
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3 Features and Functions

Measurement Input

The DAQ970A/DAQI73A allows you to combine a DMM (either internal or external) with multiplexer channels to
create a scan. During a scan, the instrument connects the DMM to the configured multiplexer channels one at a time
and makes a measurement on each channel.

Any channel that can be "read" by the instrument can also be included in a scan. This includes any combination of
temperature, voltage, resistance, current, frequency, or period measurements on multiplexer channels. A scan can
also include a read of a digital port, a read via the sense channel, or a read of the totalizer count on the multifunction
module.

The internal DMM

Atransducer or sensor converts a physical quantity being measured into an electrical signal which can be measured
by the internal DMM. To make these measurements, the internal DMM incorporates the following functions:

- Temperature (thermocouple, RTD, and thermistor)

- Voltage (DC and AC up to 300 V)

Resistance (2-wire and 4-wire up to 1GQ)

Current (DCand ACupto 1 A)
- Frequency and Period (up to 300 kHz)

The internal DMM provides a universal input front-end for measuring a variety of transducer types without the need
for additional external signal conditioning. The internal DMM includes signal conditioning, amplification (or
attenuation), and a high resolution (up to 22 bits) analog-to-digital converter. A simplified diagram of the internal
DMM is shown below:

To/From
ﬁﬂgﬁg o1 Signal AB?&?%.IO Man f//; Ea;th d
e eference
Signal O Conditioning Covorer Processor Sorcbion
A

= Optical Isolators
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Signal conditioning, ranging, and amplification

Analog input signals are multiplexed into the internal DMM's signal-conditioning section - typically comprising
switching, ranging, and amplification circuitry. If the input signal is a DC voltage, the signal conditioner is composed
of an attenuator for the higher input voltages and a DC amplifier for the lower input voltages. If the input signalis an
AC voltage, a converter is used to convert the AC signal to its equivalent DC value (true RMS value). Resistance
measurements are performed by supplying a known DC current to an unknown resistance and measuring the DC
voltage drop across the resistor. The input signal switching and ranging circuitry, together with the amplifier
circuitry, convert the input to a DC voltage which is within the measuring range of the internal DMM's analog-to-
digital converter (ADC).

You can allow the instrument to automatically select the measurement range using autoranging or you can select a
fixed measurement range using manual ranging. Autoranging is convenient because the instrument automatically
selects the range to use for each measurement based on the input signal. For fastest scanning operation, use
manual ranging for each measurement (some additional time is required for antoranging since the instrument has to
make a range selection.

Analog-to-digital conversion (ADC)

The ADC takes a prescaled DC voltage from the signal-conditioning circuitry and converts it to digital data for output
and display on the front panel. The ADC governs some of the most basic measurement characteristics.

These include measurement resolution, reading speed, and the ability to reject spurious noise. There are several
analog-to-digital conversion techniques but they can be divided into two types: integrating and non-integrating. The
integrating techniques measure the average input value over a defined time interval, thus rejecting many noise
sources. The non-integrating techniques sample the instantaneous value of the input, plus noise, during a very short
interval. The internal DMM uses an integrating ADC technique.

Main processor

The main processor, located in the floating logic section, controls the input signal conditioning, ranging, and the
ADC. The main processor accepts commands from, and sends measurement results to, the earth referenced logic
section. The main processor synchronizes measurements during scanning and control operations. The main
processor uses a multi-tasking operation system to manage the various system resources and demands.

The main processor also calibrates measurement results, performs Mx+B scaling, monitors alarm conditions,
converts transducer measurements to engineering units, time stamps scanned measurements, and stores data in
non-volatile memory.
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Scanning

The instrument allows you to combine a DMM (either internal or external) with multiplexer channels to create a scan.
During a scan, the instrument connects the DMM to the configured multiplexer channels one at a time and makes a
measurement on each channel.

Before you can initiate a scan, you must set up a scan list to include all desired multiplexer or digital channels.
Channels which are not in the scan list are skipped from the scan. The instrument automatically scans the list of
channels in ascending order from slot 1 through slot 3. Measurements are taken only during a scan and only on
those channels which are included in the scan list.

You can store up to 1,000,000 readings in non-volatile memory during a scan. Readings are stored only during a
scan and all readings are automatically time stamped. Each time you start a new scan, the instrument clears all
readings stored in memory from the previous scan. Therefore, all readings currently stored in memory are from the
most recent scan.

You can configure the event or action that controls the onset of each sweep through the scan list (a sweep is one
pass through the scan list):

= You can set the instrument's internal timer to automatically scan at a specific interval as shown below. You can
also program a time delay between channels in the scan list.

Trigger 1 Trigger 2
Sweep

—~—

- Trigger Timer —me—
(0 to 360,000 seconds)

- You can manually control a scan by repeatedly pressing [Scan/Start] key from the front panel.

- You can start a scan by sending a software command from the remote interface.

You can start a scan when an external TTL-compatible trigger pulse is received.

You can start a scan when an alarm condition is logged on the channel being monitored.
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Scanning with External Instruments

You can use the DAQ970A/DAQ973A for signal routing or control applications. If you install a multiplexer plug-in
module, you can use the DAQ970A/DAQ973A for scanning with an external instrument. You can connect an external
instrument (such as a DMM) to the multiplexer COM terminal.

8 H@—c\\oi

L S—e Ne
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puay L . O {External DMM ]
Channels o ( mmnm‘ :::‘\
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L R Common Terminals
N e (COM) \
2 H )
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To control scanning with an external instrument, two control lines are provided. When the DAQS70A/DAQ973A and
the external instrument are properly configured, you can synchronize a scan sequence between the two.

External DMM

VM Complete OUT Ext Trig IN
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The Multifunction Module

The multifunction module (DAQM907A) adds two additional measurement input capabilities to the system: digital
input and event totalize.

The multifunction module also contains a dual voltage output (DAC). For more details, see Transducers and sensors.
Digital input

The multifunction module has two non-isolated 8-bit input/output ports which you can use for reading digital
patterns. You can read the live status of the bits on the port or you can configure a scan to include a digital read.
Each port has a separate channel number on the module and contains 8-bits. You can combine the two ports to read
a 16-bit word.

| »Bit0 )
@
8 e . E?}m (LSB)
€ 7 E—% annel 01
—
—@ )
Digital |—@Bit7
Input @ Bit 0 B
L&
8 — 2 . Port2(MsB)
< 7 —@ Channel 02
@
@ Bit7

Totalizer

The multifunction module has a 26-bit totalizer which can count pulses at a 100 kHz rate. You can manually read the
totalizer count or you can configure a scan to read the count.

——@ +IN )

—@ -IN
Totalize > Channel 03
L ® Gate

—& Gate

26 Bits
7

v

You can configure the totalizer to count on the rising edge or falling edge of the input signal. The maximum count is
67,108,863 (226-1). The count rolls over to "0" after reaching the maximum allowed value. You can configure the
totalizer to read without affecting the count or reset the count to zero without losing any counts.
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Control Output

In addition to signal routing and measurement, you can also use the DAQ970A/DAQ973A to provide simple control
outputs. For example, you can control external high-power relays using the actuator module or a digital output
channel.

The multifunction module

The multifunction module (DAQM907A) adds two additional control output capabilities to the system: digital output
and voltage (DAC) output.

The multifunction module also contains digital input and event totalizer capabilities. For more details, see The
Multifunction Module.

Digital output

The multifunction module has two non-isolated 8-bit input / output ports which you can use to output digital
patterns. Each port has a separate channel number on the module and contains 8-bits. You can combine the two
ports to output a 16-bit word.

8 —@ Port 1 (LSB)
# 3 7~ Channel 01

e —@Bit7
Digital <
Output [—@Bit0

8 @ \ Port 2 (MSB)
Channel 02

Voltage (DAC) output

The multifunction module has two analog outputs capable of outputting calibrated voltages between £12 V with 18
bits of resolution. Each DAC (Digital-to-Analog Converter) channel can be used as a programmable voltage source
for analog input control of other devices. A simplified diagram is shown below:
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: Output Voltage
bt 4> DAC
Digital Data — %

!

3

You can set the output voltage to any value between £12 VDC, in 100 pV steps. Each DAC is earth referenced, it
cannot float. Each DAC channel is capable of supplying 15 mA maximum current during output voltage mode. Or
you can set the DAC to constant current mode, to output any current between +24 mA, in 0.2 pA steps.

Each DAC channel is capable of supplying 24 mA maximum current.

NOTE You must limit the output current to 40 mA for each slot (two DAC channels).

The actuator/general purpose switch

You can think of the DAQM903A Actuator as a control output because it is often used to control external power
devices. The actuator provides 20 independent, isolated Form C (SPDT) switches.

Channel Open Channel Closed
(NC Contact Connected) (NO Contact Connected)
o—) NO o—) NO
NO = Normally Open *
NC = Normally Closed o—2 NC o—@NC
2 COM cCOoM

Each channel can switch up to 300 V DC or AC rms. Each switch can also switch upto 1 ADC or AC rms up to
maximum 50 W. For example, the maximum current that you can switch at 120 V is 0.45 A as shown below:

Voltage
300 =
N
120
100 = =
50 = . N
30 - =1 \.
\
Current
2 bt 1
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For control applications, the actuator has the following advantages:

Higher voltage and power rating than the digital output channels. The actuator switches can also be used to control
power devices.

When used with high-power devices, however, it is critical that you provide protection to the switch from capacitive
and inductive loads to ensure maximum relay life.

For more information on attenuators, see Using Attenuators.
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Front Panel Menu References

Table below summarizes the front panel keys and the menu structure.

Key

@

Description

Initiates/stops a scan/digitize process, or performs a single sweep in manual trigger mode.

Press once to initiate a scan/digitize; press and hold to stop the operation.

The key's backlight is turned on while scanning/digitizing is in progress.

In DMM Digitize, and Digitizer data acquisition mode, the key's backlight is also turned on while auto save is in
progress

In Scan data acquisition mode, the instrument automatically scans the configured channels in consecutive
order from slot 1 through slot 3. Channels that are not configured are skipped.

In DMM Digitize data acquisition made, the instrument automatically starts the DMM digitizing operation on a
single configured channel.

In Digitizer data acquisition mode (only supported on the DAQM909A plug-in module), the instrument auto-
matically starts the digitizing operation for all the configured channels simultaneously.

= Monitors a channel's measurement data that is useful for troubleshooting the instrument and observing an

important signal.
You can select to view the monitor measurements in number, bar meter, trend chart, and histogram format.

The key's backlight is turned on while monitoring is enabled. The monitor annunciator will also be displayed,
and the sample annunciator will flash when monitoring is made. In the event the Digitzer data acquisition
mode is enabled, the key's backlight will be turned off but the annunciator will continue to be displayed on
screen indicating that the monitor operation is still running in the background.

To stop the monitoring mode and return to Home menu page, press this key again on the Monitor menu page.

Brings up the Home page that displays the instrument information and a list of help topics the in selected local
language.

Selects the data acquisition mode to be used (Scan, DMM Digitize, or Digitizer).
Measures the offset on strain channels.

Configures the four alarm output hardware lines.

Configures various user preferences.

= Views scanned memory readings.

View digitized readings.
Views alarm queue.
Views error queue.

Performs and views power analysis.

= Channel labeling.

Closes or opens switches on switching channels.
Selects measurement function.

Selects measurement range or autorange.
Selects the integration time.

Configures advanced measurement features.
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Interval

- Configures what starts each sweep, or the interval between sweeps, and the number of sweeps during the

scan.

Configures the sample timer, sample count and trigger settings for the digitzer.

Math

- Configures the measurement scaling (mX+b, %, dBm, or dB) on the current channel.

Copy

- Copies the measurement configuration from the selected channel(s) to other channel(s).

Alarm

— Configures alarm on the selected channel. There are four configurable alarms in this instrument.

Utility

- Self-test.

Calibration.
Autocalibration. Instrument security (NISPOM).

Firmware update.

Overview of the scan list for the module.
Performs a module reset.

Module labeling.

Views information on the internal DMM.

Views information on modules' relay cycle.

(7
()
<
(1)

Recall
Local

Saves and recalls instrument state files (.sta extension) and preference files (.prf extension).

— File management.

Saves the readings from trend chart or histogram.

Captures and saves the screen image.

Instrument factory reset and system preset.

Data logging to a USB drive on the front panel.

Auto save digitizer data to a USB drive on the front panel.

Returns the instrument into local control when the instrument is in remote.
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[Scan/Start] Key

Press the [Scan/Start] key on the front panel to initiate any scanning or digitizing operations, or to perform a single
sweep/record when operating in manual trigger mode. See the [Interval] Menu for more information on how the
[Scan/Start] key is used when the manual trigger mode is selected.

The [Scan/Start] key's backlight is turned on while scanning/digitizing is in progress. To stop the scan or digitizer
operation, press and hold the [Scan/Start] key for more than 2 seconds. In Scan data acquisition mode, "Scan
stopped" is shown when the operation is terminated. Likewise, in DMM Digitize and Digitizer data acquisition mode,
"DMM Digitize stopped" and "Digitizer stopped" will be shown respectively when the operation is terminated.

NOTE When the Auto Save feature in the [Save Recall] menu is turned on for DMM Digitize/Digitzer data acquisition
mode, the digitizing operation will not begin unless the instrument detects a USB drive connected to the USB
port at the front panel.
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[Monitor] Menu

The [Monitor] menu features are not available for Digitizer data acquisition mode.

In Scan/DMM Digitize mode, you can monitor the measurement data on a selected channel by pressing the
[Monitor] key. The key's backlight is turned on while monitoring is enabled. The monitor annunciator will also be
displayed, and the sample annunciator will flash when monitor measurements are made.

In Scan mode, you can view the monitor data for all channels, except for computed channels (channels 407 through
420). Monitoring of computed channels is only available while scanning and will only display the reading from the
most recent sweep. You can also view monitor data on the DAQM907A digital I/0 and totalizer channels even if they
are not in the scan list.

Monitor measurements are made repetitively when scanning is idle or between sweeps of a scan. To stop the
monitoring mode and return to the Home menu page, press the [Monitor] key again on the Monitor menu page.

In DMM Digitize mode, you can only view the monitoring data of the single channel that is configured for DMM
Digitize. The data will only be displayed as a number and its related Minimum, Maximum, and Peak to Peak data if
the Peak On/Off softkey is toggled to On.

However in Scan mode, you may choose to display the monitoring data in the following formats: Number, Bar Meter,
Trend Chart, or Histogram. To configure, press Display softkey to select your desired display mode. The example of
the softkeys is shown below.

!—Select Display Mode —————————

Bar Trend

Meter Chart Histogram

‘ Number ‘
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Number

Displays readings as a number

Monitor | » @
201 Armature relay MUX Channel

+000.034x

(Peak -
P-P:+154.17mvDC

Min= 0.218m Average:+ 0.005 2m 45m
Span: 0.463m Stddev: 0.055 6m Samples:33 785

Monitor Menu
Display Peak Clear Clear Statistics
Number 0ff On EUE Mon Data Hide Show
Softkey Description

Peak On/Off Press the Peak softkey to toggle between enabling (On) or disabling (Off) the measurement of the
Minimum, Maximum, and Peak to Peak values acquired within the measurement aperture.

Clear Peaks Press the Clear Peaks softkey to reset the reading of peak values. This is done by clearing the
accumulated history of peak-to-peak function.

NOTE The Clear Peaks softkey will only be displayed when Peak is set to On.
Clear Mon Data Press the Clear Mon Data softkey to clear the statistics, trend chart, and histogram on the monitor
channel.

NOTE The Clear Mon Data softkey will only be displayed when Statistics is set to

Show.
Statistics Press the Statistics softkey to toggle between Hide or Show the measurement statistics for the monitor
Hide/Show channel. Monitor channel statistics are cleared when monitor mode is turned on, when the monitor

channel changes, or when the monitor channel's configuration is changed.
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Bar Meter

The bar meter adds a moving bar below the standard Number display.

Monitor . M
201 Armature relay MUX Channel

+000.021mvoc

Auto

100mV Peak P-P+154.22m Max+077.64m  Min-076.58m
l! 100m

Min= 0.218m Average+ 0.005 Om Max+ 0.245m
Span:  0.463m Stddev: 0.057 2m Samples:85 043

Monitor Menu

Display Scale Peak Clear Clear Statistics
Bar l 0ff On Peaks  |Mon Data Hide Show

Scale Default Default sets the scale to the measurement range.

Manual (-1(0.000 OmV

Scale Lows High
Manual Center Span

Manual allows you to configures the scale either as High and Low values or as a Span around a Center
value. For example, a scale that goes from a Low of -500 Q to a High of 1000 Q could also be specified as
a Center of 250 Q with a Span of 1500 Q.

Limits Limits set the scale to the alarm limits.

This softkey is only available when you configure alarm on the selected channel
by pressing the [Alarm] key on the front panel.

Peak On/Off Press the Peak softkey to toggle between enabling (On) or disabling (Off) the measurement of the
Minimum, Maximum, and Peak to Peak values acquired within the measurement aperture.

Clear Peaks Press the Clear Peaks softkey to reset the reading of peak values. This is done by clearing the
accumulated history of peak-to-peak function.

The Clear Peaks softkey will only be displayed when Peak is set to On.
Clear Mon Data Press the Clear Mon Data softkey to clear the statistics, trend chart, and histogram on the monitor
channel.
The Clear Mon Data softkey will only be displayed when Statistics is set to Show.
Statistics Press the Statistics softkey to toggle between Hide or Show the measurement statistics for the monitor

Hide/Show channel. Monitor channel statistics are cleared when monitor mode is turned on, when the monitor
channel changes, or when the monitor channel's configuration is changed.
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Trend Chart

In the Continuous measurement mode, the trend chart shows data trends over time. Data is collected and displayed
in pixel columns as described below:

" Monitor |
201 Armature r... +000.023mVDC
200y} i

-200p:

o N
T

-1m00s

Min:= 0.157m Average+ 0.006 8m Max+ 0.169m
Span:  0.325m Stddev: 0.052 Om Samples: 908

Monitor Menu

Display Recent  Vertical [Autoscale Clear Statistics
Trend Al Scale ’ Once  |Mon Data Hide Show

Recent/All The Recent/All softkey specifies whether all measurements (All) or only the most recent measurements
(Recent) are shown on the trend chart. Neither selection clears reading memory. In All mode, the trend
chart displays all readings being taken and builds from left to right. After the display is filled, the data
becomes compressed an the left side of the display as new data is added on the right side of the display.
In Recent mode, the trend chart displays data taken during a specified amount of time.

Vertical Scale Default Default sets the scale to the measurement range.
Auto Auto automatically adjusts the scale to appropriately fit the line currently shown on the screen.
Manual (-2(00.000 OpV

Vertical Lows High
Manual Center Span

Manual allows you to configure the scale either as High and Low values or as a Span around a Center
value. For example, a scale from a Low of 0 V to a High of 5 V is equivalent to a Center of 2.5 V and a Span

of b V.
Limits Limits set the scale to the alarm limits.
This softkey is only available when you configure alarm on the selected channel
by pressing the [Alarm] key on the front panel.
Autoscale Press Autoscale Once softkey to automatically scale the trend chart's vertical axis one time based on the
Once scanned memory readings shown on the screen. This also sets the Vertical Scale mode to Manual.
Clear Mon Data Press the Clear Mon Data softkey to clear the statistics, trend chart, and histogram on the monitor
channel.
The Clear Mon Data softkey will only be displayed when Statistics is set to Show.
Statistics Press the Statistics softkey to toggle between Hide or Show the measurement statistics for the monitor
Hide/Show channel. Monitor channel statistics are cleared when monitor mode is turned on, when the monitor

channel changes, or when the monitor channel's configuration is changed.
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Histogram
The histogram shows measurement data as a graphical representation of the distribution of measurement data.
Data is grouped in bins represented by vertical bars in the histogram display.

~ Monitor |+ ¥ _ _
201 Armature r... -000.110mVDC

1417
2.9%
Total
4878
#¥Bing .

100 -300p 0.000 00

Min= 0.234m Average+ 0.004 8m Max:+ 0.214m
Span.  0.448m Stddev: 0.078 4m Samples:4 878

Monitor Menu

Display Cursors Clear Statistics
Histogram | Mon Data Hide Show

Cursors Cursors Press the Cursors softkey to toggle between enabling (On) or disabling (Off) the histogram's cursors
Off/ On
B1 Use the knob or arrow keys to adjust the position of cursor B1 (Violet dotted vertical line).
B2 Use the knob or arrow keys to adjust the position of cursor B2 (Green dotted vertical line).
Clear Mon Data Press the Clear Mon Data softkey to clear the statistics, trend chart, and histogram on the monitor
channel.

The Clear Mon Data softkey will only be displayed when Statistics is set to Show.

Statistics Press the Statistics softkey to toggle between Hide or Show the measurement statistics for the monitor
Hide/Show channel. Monitor channel statistics are cleared when monitor mode is turned on, when the monitor
channel changes, or when the monitor channel's configuration is changed.
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Cursors in the histogram are specified as bin numbers and display the range of values covered by those bins, the
count and the percentage of the total. The total count and percentage of total, as well as the measurement range
covered, between the cursor bins, are also displayed.

In the example below, cursor B1 (violet vertical lines) is positioned on bin number 30 and cursor B2 (green vertical
lines) is positioned on bin number 50 (bin number shown above the B2 softkey). The bin information for cursor B1 is
shown in the violet box and the bin information for cursor B2 is shown in the green box.

Monitor

201 Armaturer... -000.048mVDC

9247
2.5%
Total -
37.16k
# Bins

100 -300p 0.000 0D

Bl- 0.126m  to- 0.120m #4643 1.19%  Span: 0.126m
|BZ2= 0.006m to+ 0.000m #797 2.16% | #1566k 42.1%

Cursors B1 B2
off On =2

Based on the example above, the information for cursor B1 can be interpreted as follows:
- 0.126m 10 0.120m - Range of DCV measurement values for this bin.
— #443 - Number of samples in this bin.

= 1.19% - Percentage of the total number of samples in this bin.

The data between the B1 and B2 cursors, including the data in the BT and B2 bins, is shown to the right of the violet
and green boxes. In the graphic above:

= Span: 0.126m - The measurement range covered from B1 to B2.
- #15.6k - The number of samples from B1 to B2.

— 42.1% - The percentage of the total number of samples from B1 to B2.
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[Home] Menu

Press the [Home] key to access the instrument's Home page. On the Home page, an overview of the instrument's
current status and operation will be displayed on the main screen. In the Home menu, you will also be able to access
the instrument's help topics here and configure various settings such the instrument's acquire mode, strain offset,
alarm output hardware lines, and user's preferences.

The instrument will return to the Home menu page when monitoring mode is stopped.

Home )

Next Sweep: Stopped Start Time:
Sweeps Count: 0

N/A
SCAN

Interval: 00:00:00
Count: 1

Log to USB: Yes

Home Menu

Acquire Alarm Out Help User
Scan [ l I Settings

Data acquisition mode

Press the Acquire softkey to select a data acquisition mode.

DM

Eeal Digitize

Digitizer

Acquire Scan The instrument continuously scans through all configured channels and performs measurements.
DMM The instrument digitizes the signals of a single configured channel using the internal DMM.
Digitize

Digitizer The instrument digitizes up to 4 configured digitizer channels simultaneously for each DAQM309A plug-in
module inserted in the instrument using the DAQM909A's onboard digitizers. In other words, a maximum
of 12 configured channels can be digitize simultaneously when the DAQ970A/DAQ973A is installed with 3
DAQM909A plug-in modules. It can also operate in parallel to a Scan or DMM Digitize data acquisition
operation as it utilizes the DAQM909A's onboard digitizers instead of the instrument's internal DMM.

The Digitizer softkey will only be available when the DAQM9I09A module is
inserted into the mainframe.

Keysight DAQ970A/DAQ973A User's Guide 71



3 Features and Functions

Strain offset

This softkey is only available after you configured the channel for strain measurements by pressing
[Channel] > Measure, and select STRAIN with DAQM9I00A, DAQM901A, DAQM902A, DAQMI08A, and
DAQM909A modules. See Strain for details.

Home |
Next Sweep: Stopped Start Time:
-

Sweeps Count:

N/A
Scan List

Interval: 00:00:00
Count: 1
Log to USE: No

Home Menu

Acquire Strain  Alarm OQut Help User
Scan | Offset 5 | Settings

Strain offset is also known as the unstrained value. You can select one or more channels on which you want to
measure the offset value. The strain formula will automatically use this offset value when calculating the
measurement result.

Unstrained | ™

Check W EN T Units
101 Armature rel N

Current Page: 1/1

Done
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To configure the strain offset:

1.

Use the knob or the front panel arrow keys to navigate across the list and press the Select softkey to enable the
strain offset measurement on the highlighted channel. The selected channel is marked with an "X". Press the
Select softkey again to disable the offset measurement on the highlighted channel. Note that upon pressing this
softkey will also enable the Measure Now and Clear Offsets softkeys.

Unstrained |

Check

[x] 101 Armature rel;

102 Armature r
[x] 103 Armaturer

2. Press Select All to enable the offset measurement on all listed channels. Press this softkey again to disable the

offset measurement on all listed channels.

Unstrained | ]

Check Channel Offset Units
ann m¥y0C

+0.0000

+0,0000

+0.0000

3. Press Measure Now to immediately measures the offset value on the selected channel(s). Offset readings will dis-

play on the screen as shown below:

Unstrained |
Channel Units
T - ¢ ! mYOC
oc

AUX Channe g mYDC
AR Channel o 177 myOC

4. Press Clear Offsets softkey if you would like to immediately clear the strain offset value to O on the selected chan-

nel(s).
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Alarm output

Configures the four alarm output hardware lines. Four TTL-compatible alarm outputs are available on the rear panel
Ext Trig/Alarms connector. You can use these hardware outputs to trigger external alarm lights, sirens, or send a
TTL-compatible pulse to your control system. You can assign an alarm to any configured channel and multiple
channels can be assigned to the same alarm number. Each alarm output line represents the logical "OR" of all
channels assigned to that alarm number (an alarm on any of the associated channels will pulse the line).

Alarm 4 Qutput
Alarm 3 Qutput
Alarm 2 Qutput
Alarm 1 Output

5 1

00000

{o iy o) Vo £

9 6
Gnd

Alarms Connector

Press the Alarm Out softkey to configure the output alarm.

Clear Clear Mode Out Alarm
All Latch Neg Pos

Softkey Description

Clear Alarm 1 Clears the state of a specified alarm output line (Alarms 1 through 4).
Alarm 2
Alarm 3
Alarm 4
Clear All Clears the state of all four alarm output lines.
Mode Latch The alarm output is asserted when a channel's reading crosses a limit, and remains asserted until you

clear it manually, start a new scan, or cycle power.

Track The alarm output is asserted when a channel's reading crosses a limit, and remains asserted only while
subsequent readings remain outside the limit. When a reading returns within the limits, the output is auto-
matically cleared.

Out Alarm Neg Configures the level for all four alarm output lines to indicate an alarm at 0 V (TTL-compatible low).

Pos Configures the level for all four alarm output lines to indicate an alarm at 3.3 V (TTL-compatible high).

Help topics

Displays the instrument information and a list of help topics in the selected local language. See Use the Built-In Help
System for details.
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User settings

Configures user preferences that control how the user interacts with the instrument. These settings are saved in
non-volatile memory and can be saved in a preferences (.prf) file.

170 Power On Display Done
Options

Language Date /
English Time

1/0

Configures the I/0 parameters for remote operations over the LAN and USB interfaces.

SCPIID LAN LAN LAN USB Done
Off On Settings Reset Settings

Softkey Description

SCPI'D SCPI'ID determines the manufacturer and model number returned by identification query (*IDN? command). The serial
number and version information are unaffected. Use this setting to avoid changing existing test system code where
the manufacturer or model number are verified and to maximize backwards compatibility with the Keysight 34970A
and 34972A. The default settings return "Keysight Technologies" followed by the model number "DAQ970A". For more
information, see the *IDN? and SYSTem:PERSona Subsystem commands in the Keysight DAQ970A/DAQI73A
Programming Guide.

Important: In order to update the instrument firmware from remote, the model number in the *IDN? response must
match the actual instrument model number. If you have changed the instrument's *IDN? response to another
instrument, when attempting to update the firmware from remote, you will see this error: The instrument is not
supported by this firmware file. To update the firmware, either update using the front panel procedure or, from remote,
use SYSTem:PERSona:MODel to set the *IDN? to match the actual model number, update the firmware, and then use
SYSTem:PERSona:MODel again to set the *IDN? response to the other model number.

LAN On/Off Refer to Enable or disable LAN interface
LAN Setting Refer to LAN Settings

LAN Reset Refer to LAN Reset

USB Setting Refer to USB Settings
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Power On

Configures the instrument's power-on state and power-on message.

Power On Power On Done
Factory Message
Softkey Description
Power On Last At power up, the instrument loads the previous state it was in during power down.
User At power up, the instrument loads up a user-selected state file.
Defined
Factory At power up, the instrument loads up the factory default state.
Defaults
Power On Power On Message sets a message that is displayed when the instrument powers up and when you press
Message [Home] > Help >About. Use the knab or the front panel arrow keys and [Select] key to select the letters. Then
press Done to exit and save the message. The message will appear as shown below when you turn the
instrument on or press [Home] > Help > About.
Display Options

Configures the instrument's display.

[ 100 %

Display Brightness Colors Scrn Svr
0ff On A B Off On

You can enable or disable the display, adjust the brightness (10 to 100%), pick a color scheme, and enable or disable
the screen saver. If you turn off the display, press any front panel key to turn it on again. By default, the screen saver
increases display life by dimming the display during long periods of inactivity. You may disable this screen saver from
the front panel only. The display is enabled when power is cycled, after an instrument reset (*RST), or when you
return to local (front panel) operation. Press the [Local] key ([Save Recall] key) to return to the local state.

DMM On/Off

Enables or disables the internal DMM. The - annunciator will display when internal DMM is disabled. Once
disabled, the DMM Digitize option will not be available when selecting the data acquisition mode.

Language
Selects the local language for front panel use.

All messages, context-sensitive help, and help topics appear in the selected language. The menu softkey labels are
not translated.
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Date/Time

Sets the date and time of the real-time clock in 24-hour format. The real-time clock does not automatically adjust
for time zone changes or daylight savings time. Be sure to set the date and time when you first receive your
instrument. Use the knob or the front panel arrow keys to set the year, month, day, hour, and minute.

2019 /06 /04 10:34:17

—

Year Month Day Hour Minute Done

Number Format

Number Format specifies how numbers are displayed on the front panel: 12,345.6 or 12.345,6. Other possibilities
also exist. For example, you can use the space as a separator.

Decimal Pt Separator Done
Period Space i
Sounds

Enables or disables the tone heard associated when an error is generated from the front panel or remote interface
(Beeper), or the click heard when keys are pressed (Key Click).

Beeper Key Click Done
Off On  Off On '
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[View] Menu

Press [View] on the front panel to view the scanned memory readings, digitized readings, alarm queue, or error
gueue. In the View menu, you can also perform various post processing measurements as well as power analysis on
the digitized readings.

The options within the [View] menu will vary depending on the selected data acquisition mode in the [Home]
menu ([Home] > Acquire > Scan, DMM Digitize, or Digitizer).

[View] Menu in Scan mode

Home Menu

Acquire Alarm Out Help User
Scan ! : | Settings

Display ~ Browse Alarms Errors
List |

Selecting the display mode

Press the Display softkey to select a display mode.

——3elect Display Mode ———8 ——

; Trend ; fo bl
List Chart Histogram Statistics

List

Displays the scanned memory readings in list format. Use the knob and arrow keys to scroll across the readings in
different pages.

" Scan Memory |

Date Time Channel Reading |
] -3.409 mvDC "
uvoC
uvoC
uvoC
uvoC

Current Page: 1,

List | ‘ Alarms Errors
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Browse First Page  Press the First Page softkey and the display will return the scan list back to Page 1.

LastSweep  Press the Last Sweep softkey and the readings from the most recent sweep.

Trend Chart

Displays the scanned memory readings in trend chart format. Use the knob and arrow keys to scroll across the
readings

Scan ]
101 Armature relay MUX Channel

1
I
+
1T
1
1
I
T M
T
3
I
LE

#Readings:3 751

Display™"| Sottings Alarm: I Errors
Trend |

To configure the trend chart, press the Settings softkey to bring up the trend chart settings menu.

Vertical [Autoscale Advanced Done

Vertical Scale Default Default sets the scale to the measurement range.
Auto Auto automatically adjusts the scale to appropriately fit the line currently shown on the screen.
Manual -2E]I.IIIIII opv

Vertical Lowy High
Manual Center Span

Manual allows you to configure the scale either as High and Low values or as a Span around a Center value.
For example, a scale from a Low of 0 V to a High of 5 V is equivalent to a Center of 2.5V and a Span of 5 V.

Autoscale Press Autoscale Once softkey to automatically scale the trend chart's vertical axis one time based on the
Once scanned memory readings shown on the screen. This also sets the Vertical Scale mode to Manual.
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Advanced

Pan

Press the Pan softkey to pan and select which reading in memory is displayed at the center of the screen.
Press and release an arrow key to move the cursor by one display pixel. Hold down an arrow key to move the
cursor in 20-display pixel increments.

NOTE The number of data displayed pixel will vary depending on the zoom level.

Zoom

Press the Zoom softkey and use the knob or the up/down arrow keys to select the amount of zoom, in
percent. You can configure the zoom percentage of the trend chart at 0.02%, 0.05%, 0.1%, 0.2%, 0.5%, 1%,
2%, 5%, 10%, 20%, 50%, 100%, 200%, 500%, or 1000%.

NOTE To pan one reading at a time, set the zoom level to 1000%. After selecting a

reading of your interest, you can then decrease the zoom level, if necessary, to
view the surrounding signal.

Cursors

Display and control X1, X2, Y1, Y2, and tracking cursors (shown as lines) on the trend chart. X cursors are
vertical lines along the sample or time axis and Y cursors are horizontal lines along the measurement
(magnitude) axis in units of the selected measurement.

X Only Y Only X and Y Track

Rdng at X

- Press the Off softkey to disable the cursors displayed.

— Press the X Only softkey to display the X1 and X2 cursors. Press the X1, or X2 softkeys and use the knob
or arrow keys to adjust the cursor position along the X axis (time). To keep X1 and X2 cursors at a fixed
distance from each other, press the AX Lock softkey to toggle it to On. The values of each point and the
delta between the two points are displayed below the trend chart.

— Press the Y Only softkey to display the Y1 and Y2 cursors. Press the Y1, or Y2 softkeys and use the knob
or arrow keys to adjust the cursor position along the Y axis (magnitude). To keep Y1 and Y2 cursors at a
fixed distance from each other, press the AY Lock softkey to toggle it to On. To set the Y1 or Y2 cursor to
avalue that puts it into view on the trend chart, press the Y1, or Y2 softkey followed by the Place Yn on
Screen softkey. The values of each point and the delta between the two points are displayed below the
trend chart.

— Pressthe Xand Y softkey to display all the X and Y cursars on the trend chart. Press the X1, X2, Y1, or
Y2 softkeys and use the knob or arrow keys to adjust the cursor position along their respective axis. The
values of each point and the delta between the two points are displayed below the trend chart.

— Press the Track Rdng at X to view the time and magnitude values of any two points in the trend chart.
First, select two readings using the X1 and X2 softkeys to position cursors X1 and X2 on the point of
interest along the time axis. The Y1 and Y2 cursors will automatically track the position of X1 and X2
cursors respectively and display the respective magnitude axis values of the X1 and X2 cursors. The
values of each point and the delta between the two points are displayed below the trend chart. You may
also fixed the distance of X1 and X2 cursors by toggling the AX Lock softkey.

— Torecord the X and Y data and the delta X and Y data as a screen shot, take a screen shot of the Web Ul,
not the front panel screen shot utility.

Reset Pan

Press the Reset Pan softkey to set the center reading to "0".
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Below is an example of a trend chart with Track Rdng at X function. The violet colored dotted lines are cursors X1,Y
while the green colored dotted lines are cursors X2,Y2. The values of each point and the delta between the two
points are displayed below the trend chart.

Scan | | _
101 Armature relay MUX Channel '

| X1:615.72ms | [ XZ2.164104s | AX: +1.02621s
YT -7762750 ] [ Y2: 119,142y ] AY:295.417y

Histogram

Displays the scanned memory readings in histogram format.

Scan 1
101 Armature relay MUX Channel

2152
3.6%

Total
59.05k

# Bins - 1
100 -750p -50p

Venu
I_Jlsplay Settings Refresh Alarms Errors
Histogram |

Press the Settings softkey to access the cursors menu.

Cursors

off On &

Cursors Cursors Press the Cursors softkey to toggle between enabling (On) or disabling (Off) the histogram's cursors
Off/ On
B1 Use the knob or arrow keys to adjust the position of cursor B1 (Violet dotted vertical ling).
B2 Use the knob or arrow keys to adjust the position of cursor B2 (Green dotted vertical line).

Press the Refresh softkey to recalculate the histogram which will include new readings.
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Statistics

Displays the scanned memory readings of a selected channel in statistics format (Maximum, Minimum, Peak to Peak,
Average, and Standard Deviation). Toggle between Statistics to display the per-channel statistics and Pk Times to
display the time of occurrence of the per-channel minimum and maximum peak readings.

Scan Stats |

Ch Max i Pk-Pk Average StdDev
1m by 734u -54.9u 134.7u

Menu Current Page: 1/1
Display Statistics
Statistics Pk Times Alarms Errors

View the alarm queue

In View menu page, press the Alarms softkey to display the first 20 alarms, including the reading and time stamp, in
the alarm queue. You are only able to view this alarm queue when the alarm limit is configured on the selected
channel by pressing [Alarm] key on the front panel. See [Alarm] Menu for more details.

Alarms s |

Channel Alarm Limit Unit Date Time
101 1 High 3
1M 1 High
10 i High
101 High
10 ' High
1M i High
1M ' High
1m 1 High

o 0
00

o o O
s [l B |

Current Page: 1/1

View the error queue

In View menu page, press Errors to display up to the 20 errors in the error queue. Error annunciator, ED is cleared
as you read them. When the front panel Error annunciator (ERR) turns on, one or more command syntax, execution,
or hardware errors have been detected. A record of up to 20 errors is saved in the instrument's error queue. Errors
are retrieved in first-in-first-out (FIFO) order. The first error returned is the first error that was saved. Errors are
cleared as you read them. When you have read all errors from the queue, the ERR annunciator turns off and the
errors are cleared. The instrument beeps once each time an error is generated. If more than 20 errors have occurred,
the last error saved in the queue (the most recent error) is replaced with "Error queue overflow". No additional errors
are stored until you remove errors from the queue. If no errors have occurred when you read the error queue, the
instrument responds with "No error".
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[View] Menu in DMM Digitize or Digitizer mode

Trend
201 Digitizer Channel

+ L2

504
VvDC

View Menu

Display Measure Vertical& Pan& Err All
Trend _lSettings _I_Gursnrs i Zoom ors Detail

A
201 Digitizer Channel '

250 000 500 IJI]I.']

Index Decirmation

Wmdnw Find Recurd Find
~Center | Trigger Peak Errors Detall

Selecting the display mode

Press the Display softkey to select either Trend or Power as the display mode.

By default, only the Trend option will be shown. The Power option will only be available in the Display menu
when the instrument's acquisition mode is set to Digitizer at the Home menu and the Pwr. Alys (Power Ana-
lysis) option is turned on in the Channel menu. See Power Analysis for more information.
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All/Detail softkey
Press the All/Detail softkey to toggle between how the trend graph is shown on the display.

In DMM Digitize data acquisition mode, the All/Detail softkey will only be available when there is a minimum of
401 digitized samples.

All view

When Allis selected, the instrument will display all the digitized samples on the screen. This allows you to have an
overview of the all the digitized samples. In the All view, there will also be a window which you can pan across the
digitized samples to select a portion of the digitized samples, up to 400,000 samples (maximum window size), to be
displayed on the screen in the Detail view.

In the image shown below is an example where 500,000 samples were digitized and in the All view, all 500,000
samples are shown on the screen. The window encloses 400,000 samples (Readings #50,000 to #450,000) where
the center is at reading #250,000. When you switch to Detail view, only readings #50,000 to #450,000 will be shown
on the screen.

All ;
201 Digitizer Channel

20p;

i

~1047}

-4y — ——————]
_ VDCp 250 000 500 000

.i_!aalllnn "ZEGUUU Index Decimation
Window Find Record Find All
zGenter | Trigger | .2, Peak EETOLS Detail

Detail view

The Detail view helps to isolate points of interest from the entire set of digitized samples to ease the post processing
of the points of interest. When Detail view is selected, the instrument will display up to 400,000 samples on the
screen based on the samples which are within the window in the All view.

Trend
201 Digitizer Channel

501/

vDC 250 000

Aenu Zoom: 0.1%

Display Measure Vertical& Pan& E All
Trend Settings | Cursors , Zoom A Detail
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Settings in All view

Window Find Record Find All
~Genter | Trigger | 2, Peak Errors Detail

Softkey Description

Window Press the Window Center softkey and use the knob or arrow keys to shift the position of the window along
Center the screen. The reading at the center of the window is indicated by the pointers at the top and bottom of the
window and the number will be displayed above the softkey.

All M
201 Digitizer Channel

:::JM ”*‘1] liyl) “‘:!*tl]t{urr |\ { J

-Gﬂu

ﬁ-———

VDC 250 000 500 000
Reading Sl Index Decimation

' Window Find Record Find All
~Center Trigger .2 Peak EXTOR Detail

Find Trigger Press the Find Trigger softkey and the instrument will locate the trigger points and position the window
center on the point where the trigger occurs.

Record Press the Record softkey and use the knob or arrow keys to scroll through the list of Arm events to view the
set of data samples acquired from each respective Arm event number.

Important: If a certain Record's data is incomplete, the data of the Record will not be retrievable.

— Example #1: The digitizer channel is configured as such - Arm Count = 1, Sample Count = 1,000,000
and the digitizing operation is initiated. If you abort the operation before 1,000,000 samples have been
acquired, all acquired data in the 15t Record prior to the abort cannot be retrieved.

— Example #2: The digitizer channel is configured as such - Arm Count = 3, Sample Count = 1,000,000
and the digitizing operation is initiated. If you abort the operation during the 3" Record before
1,000,000 samples have been acquired, all acquired data in the 3 Record prior to the abort cannot be
retrieved. However the acquired data in the 15tand 2" Record is still retrievable.

Qﬁ?jﬁﬁ The Record softkey will only be available when Digitizer is selected as the data
acquisition mode ([Home] > Acquire > Digitizer)

Find Peak Press the Find Peak softkey to perform decimation on a large set of digitized data. You may pause the
decimation process by pressing the Cancel softkey and resume the decimation process by pressing the
Resume Find Pk. softkey. Do note that data points that has been decimated cannot be reverted back to its
original value.

The decimation feature is useful in improving the speed of data throughput. You may digitize a large amount
of data per record at a high sampling rate to ensure thorough data capture, but do not need to return all the
stored values. Therefore by applying decimation, the instrument returns only the minimum and maximum of
actual digitized samples from each group of samples.

Errors Press the Errors softkey to display up to the 20 errors in the error queue. The error annunciator is cleared as
you read them.
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Settings in Detail view

Yiew Menu Zoom: 0.1%

Display Measure Vertical& Pan& E All
Trend Settings | Cursors Zoom ol Detail

Measure Settings

Press the Measure Settings softkey to configure the position of markers and set the mode of data analysis.

The Measure Settings softkey will only be available once a minimum of 256 samples have been digitized.

Rms - Zoom: 0.1%

| Analysis I Add to | Remove Markers Done
Quick M. | List All
Softkey Description

Analysis Quick M. The Quick M. (Quick Measurement) option allows you to add up to four quick measurement modes to be
displayed on the screen.

To select quick measurement modes for analysis, press Analysis > Quick M.. Next, use the knob or the
arrow keys to browse through the different options. Once you have selected your desired quick
measurement option, press the Add to List softkey to add it into the list of quick measurement that will be
displayed.

The quick measurement options available are:

— Rms: Root mean square
— DCycle: Duty cycle

— PWidth: Positive width
- NWidth: Negative width
— RTime: Rising time

— FTime: Falling time

- Period

- Freq: Frequency

Statistics Press Analysis > Statistics to display statistics data such as Minimum, Maximum, Average and Standard
Deviation) on the screen.

Add to List Press the Add to List softkey to add the selected quick measurement mode to be displayed on the screen.
You may add up to four quick measurement modes to be displayed. Do note that when you add mare than
four measurement modes, the most recent measurement mode will replace the first measurement mode
which was added (First-in, first-out behavior).

Remove All Press the Remove All softkey to remove all the quick measurement modes displayed on the screen.

86 Keysight DAQ970A/DAQ973A User's Guide



3 Features and Functions

Display Toggle the Display Off/On softkey to enable (On) or disable (Off) the display of the quick measurements
Off/On data or statistics data. This setting will be reflected on all the other channels.
The Display Off/On softkey will only appear when an analysis mode (Statistics
or a Quick M. option) is selected .
Markers Please refer to Markers softkey in following section for more information.
Markers softkey

- Trend ]
201 Digitizer Channel

50p!

0

-50y

. vDe
[ s

Marker Marker

LockMrkrs

Zoom: 0.1%

Done

& 1 & 2 off On

Markers determine a range of data points which are used to compute the quick measurements and statistics. In the
image above, the two markers which are represented by green vertical lines and labeled M1 and M2 respectively.

Between Marker 1 and Marker 2, there will be a minimum of 256 data points.

Marker 1
Marker 2

LockMrkrs
On/Off

Markers

Press the Marker 1 softkey and use the knob or arrow keys to adjust the position of Marker 1 (M1).
Press the Marker 2 softkey and use the knob or arrow keys to adjust the pasition of Marker 2 (M2).

Press the LockMrkrs softkey to toggle between locking the positions of MT and M2 in a fixed
distance (On) or allowing the position of M1 or M2 to be adjusted independently of each other (Off).
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Below are some examples of what you may observe on the screen when you adjust the position of the markers:

Trend | ™ ..

201 Digitizer Channel

- Trend | ™ _

201 Digitizer Channel
50—

- Trend | ™
201 Digitizer Channel

Bopf——————————F———————————]

- Trend |
201 Digitizer Channel

50u

251 250

In the image, Markers T and 2 are positioned on data
points that are viewable on the screen.

In this image, Marker 1 is positioned on a data point
that is viewable on the screen while Marker 2 is
positioned on a data point that is not viewable on the
screen.

In'such cases, an indicator, M2>, will appear at the
bottom right of the screen to indicate that Marker 2 is
located at a data point towards the right.

In both images shown, both markers are positioned on
data points that are not viewable on the screen.

In the first image, an indicator, M1/2>, appears at the
bottom right of the screen to indicate that both
markers are located towards the right.

To bring the markers back into view; First, press the
M1 softkey and turn the knob counter-clockwise. This
will bring marker M1 back into the edge of the screen.
Next, press the M2 softkey and turn the knob counter-
clockwise again and this will bring marker M2 to the
edge of the screen. Do note that the distance between
markers M1 and M2 is now 256 data points.

In the second image, both markers are on opposite
sides. In such cases, indicators <M1 and M2> will
appear at the bottom of the screen indicating the
direction of markers.

To bring the markers back into view; First, press the
M1 softkey and turn the knob clockwise. This will bring
marker M1 back into the edge of the screen on the left.
Next, press the M2 softkey and turn the knob counter-
clockwise and this will bring marker M2 to the edge of
the screen on the right.

88

Keysight DAQ970A/DAQ973A User's Guide



3 Features and Functions

Vertical & Cursors

Press the Vertical softkey to configure the vertical scaling of the trend chart and also to access the cursors menu.

Vertical Autoscale Cursors Done
Default Once
Softkey Description
Vertical Default Default sets the scale to the measurement range.
Auto Auto automatically adjusts the scale to appropriately fit the line currently shown on the screen.

Manual Vertical Low High [Autoscale Cursors Done

M EGITEL Center Span Once

Manual allows you to configure the scale either as High and Low values or as a Span around a Center value.
For example, a scale from a Low of 0 V to a High of 5 V is equivalent to a Center of 2.5V and a Span of 5 V.

Autoscale Press Autoscale Once softkey to automatically scale the trend chart's vertical axis one time based on the
Once digitized data paints shown on the screen. This also sets the Vertical Scale mode to Manual.

Press the Cursors softkey to access the Cursors menu.

X Only Y Only XandY R Il:;i'; X
Softkey Description
Cursors Off Press the Off softkey to disable the cursors displayed.

Xonly Press the X Only softkey to display the X1 and X2 cursors. Press the X1, or X2 softkeys and use the knob or
arrow keys to adjust the cursor position along the X axis (time). To keep X1 and X2 cursors at a fixed distance
from each other, press the AX Lock softkey to toggle it to On. The values of each point and the delta
between the two points are displayed below the trend chart.

Y only Press the Y Only softkey to display the Y1 and Y2 cursors. Press the Y1, or Y2 softkeys and use the knob or
arrow keys to adjust the cursor position along the Y axis (magnitude). To keep Y1 and Y2cursors at a fixed
distance from each other, press the AY Lock softkey to toggle it to On. To set the Y1 or Y2 cursor to a value
that puts it into view on the trend chart, press the Y1, or Y2 softkey followed by the Place Yn on Screen
softkey. The values of each point and the delta between the two points aredisplayed below the trend chart.

XandY  Pressthe Xand Y softkey to display all the X and Y cursors on the trend chart. Press the X1, X2, Y1, or Y2
softkeys and use the knob or arrow keys to adjust the cursor position along their respective axis. The values
of each point and the delta between the two points are displayed below the trend chart.

Track Press the Track Rdng at X view the time and magnitude values of any two points in the trend chart. First,
RdngatX  select two readings using the X1 and X2 softkeys to position cursors X1 and X2 on the point of interest along
the time axis. The Y1 and Y2 cursors will automatically track the position of X1 and X2 cursors respectively
and display the respective magnitude axis values of the X1 and X2 cursors. The values of each point and the
delta between the two points are displayed below the trend chart. You may also fixed the distance of X1 and
X2 cursors by toggling the AX Lock softkey. See the example shown for more details.

To record the X and Y data and the delta X and Y data as a screen shot, take a screen shot of the Web Ul, not
the front panel screen shot utility.
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Pan & Zoom

Press the Pan & Zoom softkey to pan across the trend graph and also configure the zoom level.

Zoom: 0.1%

Done

Softkey Description
Pan Press the Pan softkey to pan and select which reading in memory is displayed at the center of the screen.

Press and release the arrow key to move the cursor by one display pixel. Hold down the arrow key to move
the cursor in 20-display pixel increments.

Zoom Press the Zoom softkey and use the knab or the up/down arrow keys to select the amount of zoom, in per-
cent. You can configure the zoom percentage of the trend chart at 0.1%, 0.2%, 0.5%, 1%, 2%, 5%, 10%,
20%, 50%, 100%, 200%, 500%, or 1000%.

The table below shows the list of zoom percentages with its corresponding number of data points per display pixel.

Zoom (%) Number of data points per display pixel
0.1% 1000
02% 500
0.5% 200

1% 100
2% 50
5% 20
10% 10
20% 5
50% 2
100 % 1
200% 05
500% 0.2
1000% 0.1

View the error queue

Press the Errors softkey to display up to the 20 errors in the error queue. Error annunciator, B3 is cleared as you
read them. When the front panel Error annunciator (ERR) turns on, one or more command syntax, execution, or
hardware errors have been detected. A record of up to 20 errors is saved in the instrument's error queue.

Errors are retrieved in first-in-first-out (FIFO) order. The first error returned is the first error that was saved. Errors
are cleared as you read them. When you have read all errors from the queue, the ERR annunciator turns off and the
errors are cleared. The instrument beeps once each time an error is generated. If more than 20 errors have occurred,
the last error saved in the queue (the most recent error) is replaced with "Error queue overflow". No additional errors
are stored until you remove errors from the queue. If no errors have occurred when you read the error queue, the
instrument responds with "No error".
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Power Analysis

This section describes how to configure the DAQM909A digitizer channels to perform power analysis in View mode.

Enabling the Power Analysis function in the [Channel] menu

1. Inthe [Channel] menu, use the knob or arrow keys to select either Channel 01 or Channel 03. DAQM909A's
Channel 02 and Channel 04 are always assigned as Power Coupling channels which are coupled to Channel 01
and Channel 03 respectively when the power analysis function is enabled. Therefore, any settings on Channel 02
and Channel 04 will be omitted when power analysis is enabled.

Channel 01 Channel 02
Channel 03 Channel 04

2. Next, press the Measure softkey and select DCV and configure the voltage range and sampling rate
parameters.

Channel Menu

Channel Measure Volt Range Advanced
Label DCV 1V |

3. Press the Advanced softkey followed by the Pwr. Alys softkey to toggle between enabling (On) or disabling (Off)
the power analysis function of the selected channel.

Mode Coupling Type Puir. Alys Done
Time Freq AC DC Diff On Off

When you enable the power analysis function for the selected channel, the adjacent channel linked to it will be
automatically configured as the Power Coupling channel. In the example below, Pwr. Alys is turned On for
Channel 01, and Channel 02 is automatically configured as the Power Coupling channel.

Channel | | Channel |
201 Digitizer Channel 202 Digitizer Channel

MEASURE SETTING ADVANCED : MEASURE SETTING ADV ANCED

Function: DC Voltage Input Mode: Time IF‘IJI'IC'T.I":IFI DC Volts
! v Coupling: DC Range: 1V

:Ej:arn|:||in.;:_q Rate: 100k

Couple for: Channel 201

Channel Menu

Mode Coupling Pwr. Alys Type Channel Volt Range Advanced
Time Ffreq AC DC  On Off Diff 1 | Label v |

4. Press the [Scan/Start] key to begin digitizing. Once complete, press the [View] key enter the View menu.
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Viewing the Power Analysis results

Press the [View] key to access the View menu.

f Power | W |

201 Digitizer Channel

50p;

Zoom: 0.

Display  Measure Vertical& Pan& E All
Power Settings | Cursors | Zoom ELOEe Detail

Display softkey

Press the Display softkey followed by the Power softkey in order to view the results of the power analysis.

You may continue to view each channel's current power analysis data that stored in memory, as long as the
specified channel did not begin a new digitizing operation as this will overwrite the old data.

Measure Settings softkey

Press the Measure Settings softkey to configure the power analysis parameters.

CH201 Digitizer Channel Zoom: 0.1%

Analysis Source Display Markers Done
Statistics Volt Chan Off On |

Analysis Statistics  This softkey is static as this is the only analysis option for Power Analysis.

Source VoltChan  The selected source will determine the graph that is displayed on the screen. Volt Chan will display the data
of the channel assigned to it as a function of voltage, Curr Chan will compute the data of the channel
Curr Chan  assigned to it and display as a function of current, and V* | computes the data of both Volt Chan and Curr
Chan and display the data as a function of power. Press the Source softkey to toggle between voltage
V* channel (Volt Chan), current channel (Curr Chan), or power channel (V *1). For Volt Chan and Curr Chan,
use the knob or arrow keys to assign the channels.

Gain Press the Gain softkey and use the knob or arrow keys to specify the gain value for current value
computation for Curr Chan.

Display Toggle the Display Off/On softkey to enable (On) or disable (Off) the display of data statistics on the screen.

Off/ On

Markers Please refer to Markers softkey for more information.
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Vertical & Cursors softkey

Please refer to Vertical & Cursors for more information.
Pan & Zoom softkey

Please refer to Pan & Zoom for more information.

View the error queue

Press the Errors softkey to display up to the 20 errors in the error queue. Error annunciator, E3 is cleared as you
read them. When the front panel Error annunciator (ERR) turns on, one or more command syntax, execution, or
hardware errors have been detected. A record of up to 20 errors is saved in the instrument's error queue.

Errors are retrieved in first-in-first-out (FIFO) order. The first error returned is the first error that was saved. Errors
are cleared as you read them. When you have read all errors from the queue, the ERR annunciator turns off and the
errors are cleared. The instrument beeps once each time an error is generated.

If more than 20 errors have occurred, the last error saved in the queue (the most recent error) is replaced with "Error
queue overflow". No additional errors are stored until you remove errors from the queue. If no errors have occurred
when you read the error queue, the instrument responds with "No error".
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[View] Menu Status

In the event where there is no data available to be displayed, the [View] menu will display a status text on the bottom
of the display. Below is a list of the status text and its respective description.

Status Description

“The readings in memory were made with a different  The instrument is unable to plot the data of the last completed Scan data acquisition

set of modules installed, and cannot be graphed” operation because the module card has been switched out.

"Pre-Storing" The instrument is currently collecting PreTrigger samples before entering into Wait
for Trigger state.

“No scan data in memory” No data acquired in Scan mode.

"No digitize data in memory" No data acquired in DMM Digitize and Digitizer mode.

"Scan in progress" Scan data acquisition mode is in progress.

"Digitize in progress" DMM Digitize/ Digitizer data acquisition mode is in progress.

"Wait for arm event" The digitizer is waiting for arm event before initiating the digitizing process.

"Wait for external event" The instrument is waiting for an external trigger before initiating data acquisition.

"Wait for internal event" The instrument is waiting for an internal trigger before initiating data acquisition.

"Wait for alarm event" The instrument is waiting for an alarm trigger before initiating data acquisition.

"Wait for manual event" The instrument is waiting for a manual trigger before initiating data acquisition.

"Wait for channel event" The instrument is waiting for a channel trigger before initiating data acquisition.
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[Channel] Menu

Multiplexer modules: Measurements

The Keysight DAQ970A/DAR973A supports many common measurement functions with the multiplexer module.
You can configure the measurement function on the selected channel by pressing [Channel] > Measure.

In Scan data acquisition mode, selecting Off will disable the measurement function in current selected channel. No
measurement function will be displayed in the scan list on the selected channel. The default measurement function
will set to DCV (DC Voltage).

In DMM Digitize data acquisition mode, by default the first suitable channel will automatically configured for DMM
Digitize and it will be assigned a measurement function (DCV by default). You may switch to another available
channel on the plug-in module and configure it for DMM Digitize operation instead. In contrast to Scan mode, there
is no Off function available because DMM Digitize can only utilize a single configured channel for its digitizing
operation. Therefore, the selected channel's measurement function must always be enabled.

Table below shows the overview of each supported multiplexer module on the measurement function. Click on each
link to see the details of each configuration step.

Measurement Multiplexer modules

function DAQM900A DAQM90TA DAQM902A DAQM908A
Temperature - Thermocouple J J J

Temperature - RTD J J J
Temperature - Thermistor J J J2
Strain - Bridge J J J N
Strain - Direct J J J
DC Voltage J | J
AC Voltage J J N
DC Current JH

AC Current JH

Resistance J J J
Frequency J J N
Period J | J
Diode J J N
Capacitance J J N
Notes:

[1]Channel 21 and 22 only.
[2] 2-wire measurements only. 4-wire measurements are not supported on DAQM908A multiplexer
module.
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Temperature

This section describes how to configure the selected channel for temperature measurements from the front panel.
Temperature measurements require a temperature transducer probe and the supported probes are thermocouple,
thermistor and resistance thermometer (RTD).

Thermocouple

1.

96

Connect a thermocouple to the module's screw terminals.
_l_
L| @ =

Press [Channel] > Measure, and select TEMP from the selection menu.

Channel Measure Sensor Units Integrate Advanced

Label TEMP Settings e o K Settings

Press the Units softkey to specify the temperature measurement units as °C (Celsius), °F (Fahrenheit), or K
(Kelvin). You can mix temperature units on different channels within the instrument and on the same module.

Press Sensor Settings > Sensor, specify the type of transducer probe used as TCouple, and press Type softkey
to select the type of thermocouple. Supported types are J (default), K, E, T, N, R, B, and S.

Sensor Type Done
TCouple J

Press Integrated Settings softkey to select whether the measurement integration time will be specified in terms
of Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC
provide normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and
resolution, but the slowest measurements.

. [ PLC
Integrate
NPLC Time
Softkey Description
Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line

Cycles (PLC). Only 1 PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advance Settings

Press Advanced softkey to configure the advanced settings for the measurement.

Auto Zero Reference Open Check Delay
Off On Internal Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to
Off/ On perform the zero measurement. With auto zero enabled (On), the instrument internally measures the

offset following each measurement. It then subtracts that measurement from the preceding reading. This
prevents offset voltages present on the instrument’s input circuitry from affecting measurement accuracy.
With auto zero disabled (Off), the instrument measures the offset once and subtracts the offset from all
subsequent measurements. The instrument takes a new offset measurement each time you change the
function, range, or integration time.

Reference Internal Thermocouple measurements require a reference junction temperature. You can input a known fixed
reference junction temperature (typically used for external reference junctions), use the internally
measured temperature on the module as the reference junction temperature, or use the external
thermistor or RTD measurement. Selects the reference junction source as Internal, External, or Fixed.

Fixed NOTE The External softkey option is not available when DMM Digitize is selected

as the acquisition mode.

External

Open Check Enables (On) or disables (Off) the thermocouple check feature to verify that the thermocouples are

Off/ On properly connected for measurements. When enabled, the instrument performs a resistance
measurement with each temperature to check for an open circuit. If one is detected, the result will be
shown as +Overload. If this check is not performed, measurement of an open circuit can produce a
voltage reading near zero resulting in an invalid temperature reading.

NOTE This setting is only available when Scan is selected as the acquisition mode.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected.

Auto/ Time By selecting Auto, instrument will automatically determine the channel delay based on measurement
function, range, integration time, and AC filter setting. By selecting Time, the specified delay (time in
seconds) is inserted between the relay closure and the actual measurement on each channel, in addition
to any delay that will implicitly occur due to relay settling time.

NOTE This setting is only available when Scan is selected as the acquisition mode.
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2-wire and 4-wire Thermistor

NOTE This feature is only available when Scan is selected as the acquisition mode.

1. Connect a thermistor to the module's screw terminals.

2-wire thermistor:

Hl @ B
3 R

L| @

4-wire thermistor:

Source

M
vl

Sense

2. Press[Channel] > Measure, and select TEMP from the selection menu.

Channel Measure Sensor Units Integrate Advanced

Label TEMP Settings og of K Settings

3. Press the Units softkey to specify the temperature measurement units as °C (Celsius), °F (Fahrenheit), or K
(Kelvin). You can mix temperature units on different channels within the instrument and on the same module.

4. Press Sensor Settings > Sensor and select Thermistor. Next, toggle the 2-Wire/4-Wire softkey to specify the
type of transducer probe used as 2-wire or 4-wire Therm. After that press the Type softkey to select the type of
thermistor. Supported types are 2.2K, 5K (default), and 10K.

Sensor 2-Wire Type Use as ref Done

Therm 4-Wire 5K Off On

o

Toggle Use as ref to enable (On) or disable (Off) the currently selected channel to be used as the reference
channel for subsequent thermocouple measurements that specify an external reference source.

98 Keysight DAQ970A/DAQ973A User's Guide



3 Features and Functions

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line
Cycles (PLC). Only 1 PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.

Advanced Settings

Press Advanced softkey to configure the advanced settings for the measurement.

Auto Zero Low Power Delay Done

Off On Off On Auto Time

Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Low Power Selects the low-power resistance measurement. This sources less current resulting in lower power dis-

Off/ On sipation, and less self-heating, in the resistance under test. Typically, this is about 1/10th the current
sourced for the standard resistance measurements. The approximate current sourced for each meas-
urement range is shown at the bottom of the resistance range softkeys, for example: (~ T mA).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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2-wire and 4-wire RTD

1. Connectan RTD to the module's screw terminals.

2-wire RTD:

+
Hl @ PF—

A\
.

4-wire RTD:
—~ +
H| &
Source
L r_j = y
o SR
+
Hl @
Sense

2. Press[Channel] > Measure, and select TEMP from the selection menu.

Channel Measure Sensor Units Integrate Advanced

. Label TEMP Settings oC oF K i_Settings

3. Press the Units softkey to specify the temperature measurement units as °C (Celsius), °F (Fahrenheit), or K
(Kelvin). You can mix temperature units on different channels within the instrument and on the same module.

4. Press Sensor Settings > Sensor and select RTD. Next, toggle the 2-Wire/4-Wire softkey to specify the type of
transducer probe used as 2-wire or 4-wire RTD. Then, toggle the PT100/PT100 softkey to select the nominal res-
istance, Rp, as PT100 (100 Q) or PT1000 (1000 Q). Ry is the nominal resistance of a RTD at 0 °C.

| 1(j0.000 0 O

Sensor 2-Wire PT100 Use as ref Done
RTD 4-Wire PT1000 0ff On
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5. Press Use as ref to enable (On) or disable (Off) the currently selected channel to be used as the reference chan-
nel for subsequent thermocouple measurements that specify an external reference source. This option is not
available in DMM Digitize mode.

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2, 10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.

Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced softkey to configure the advanced settings for the measurement.

Auto Zero OffstComp Low Power Delay
Off On Off On Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

OffstComp Offset compensation removes the effects of small DC voltages in the circuit being measured. The technique
involves taking the difference between two resistance measurements, one with the current source set to the
normal value, and one with the current source set to a lower value.

Low Power Selects the low-power resistance measurement. This sources less current resulting in lower power dis-

Off/ On sipation, and less self-heating, in the resistance under test. Typically, this is about 1/10th the current
sourced for the standard resistance measurements. The approximate current sourced for each meas-
urement range is shown at the bottom of the resistance range softkeys, for example: (~ 1 mA).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Strain

This section describes how to configure the selected channel for strain measurements from the front panel. When a

force is applied to a body, the body deforms. The deformation per unit length is called strain (). Strain may be either
tensile (+) or compressive (-). The DAQ970A/DAQ973A supports two types of strain measurements which are Bridge
configuration and direct resistive method.

Once you have configured strain measurement function in all strain channels, press [Home] > Strain Offset to
measure or specify the unstrained offset that will be subtracted from strain measurements before the strain
conversion is performed.

Bridge configuration

Full and half bridge in bending arrangement

This section describes how to configure the selected channel for full and half bending bridge strain gage
measurements from the front panel.

1. Connect bridge configuration source to the module's screw terminals.

Full bending bridge:

>

S

Wl @ + Strain gage 7 train gage
L e t= | N E

Strain gage ——\‘ﬁ Strain gage

o Strain gage

Strain gage

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

Channel Measure Range Sense Gage More

Label STRAIN Auto  Settings  Settings y 1of2
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3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is con-
venient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range. The Auto option is not available
in DMM Digitize data acquisition mode.

r——————————3elect Strain Yoltage Range ——————————o——

100mV

4. Press Sense Settings > Sense, specify the strain measurement method as full and half bridge in bending arrange-
ments.

[ P

Sense T Type
Bridge 5

| Bending
—

Sense Config Type
Bridge P

5. Press Gage Settings, and use the knob or the front panel arrow keys to specify various strain gage settings.

Excitation Excitation Done
Fix Ext Yoltage

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Excitation Strain bridge conversions require the voltage of the external bridge excitation. For this voltage, you

Fix/ Ext can dedicate a multiplexer channel to measure the excitation voltage, or can specify a known fixed
voltage value. Fixed (Fix) - The fixed value specified by the Excitation Voltage softkey will be used for
the strain conversion. External (Ext) - DCV measurements on the enabled reference channel will be
used for subsequent strain bridge measurements that specify an external excitation voltage source.
Note that the external DCV reference channel must be a lower-numbered channel than the strain

channel.
Excitation Use the knab or the front panel arrow keys to specify the fixed excitation voltage applied to the bridge
Voltage by an external voltage source. This value will be used to convert strain bridge measurements on the

selected channel.

Keysight DAQ970A/DAQ973A User's Guide 103



3 Features and Functions

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms
of Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC
provide normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and
resolution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.007, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2, 10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.

Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Delay Done
Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Full and half bridge in Poisson arrangement

This section describes how to configure the selected channel for full and half Poisson bridge strain gage
measurements from the front panel.

1. Connect bridge configuration source to the module's screw terminals.

Full bending bridge:

3

Strain gage

N

E Strain gage

Strain gage

Strain gage

<

Half bending bridge:

i Strain gage

R4 ~~— Strain gage

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

Channel Measure Range Sense Gage More

.! Label STRAIN Auto _@_Settings _!_Settirlgs y) 10f 2

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is
convenient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range.

(——— Select Strain Voltage Range——8 ——

100mV 1v 10V 100V 300V
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4. Press Sense Settings > Sense, specify the strain measurement method as full and half bridge in Poisson arrange-
ments.

Full

Sense Config Type
Bridge

—
| Poisson
.

i

Sense T Type
Bridge

5. Press Gage Settings, and use the knob or the front panel arrow keys to specify various strain gage settings.

[ 2000

Gage Poisson Excitation Excitation Done
Factor Ratio Fix Ext .2Voltage

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Poisson Ratio Specifies the Poisson ratio of the strain gage. Poissan ratio is defined as the negative ratio of the strain
in the transverse direction to the strain in the longitudinal direction.

Excitation Strain bridge conversions require the voltage of the external bridge excitation. For this voltage, you

Fix/ Ext can dedicate a multiplexer channel to measure the excitation voltage, or can specify a known fixed

voltage value. Fixed (Fix) - The fixed value specified by the Excitation Voltage softkey will be used for
the strain conversion. External (Ext) - DCV measurements on the enabled reference channel will be

used for subsequent strain bridge measurements that specify an external excitation voltage source.

Note that the external DCV reference channel must be a lower-numbered channel than the strain

channel.
Excitation Use the knab or the front panel arrow keys to specify the fixed excitation voltage applied to the bridge
Voltage by an external voltage source. This value will be used to convert strain bridge measurements on the

selected channel.

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms
of Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC
provide normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and
resolution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2, 10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in secands.
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Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Delay Done
Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Full bridge in bending Poisson arrangement

This section describes how to configure the selected channel for full bending Poisson bridge strain gage
measurements from the front panel.

1. Connect bridge configuration source to the module's screw terminals.

Full bending bridge:

Strain gage

A
Strain gage ;\/— Strain gage

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

Strain gage

Channel Measure Range Sense Gage More
, Label  STRAIN  Auto  Settings  Settings yy 1of2

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is
convenient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range.

r————————>=e¢lect Strain Voltage Range ——————---—

100mV 1V 10V 100V 300V

4. Press Sense Settings > Sense, specify the strain measurement method as full bridge in bending Poisson arrange-
ment.

R

Sense Config Type
Bridge e

| BendPois
Sense Config Type
Bridge <,
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5. Press Gage Settings, and use the knob or the front panel arrow keys to specify various strain gage settings.

Poisson Excitation Excitation Done
Ratio Fix Ext .2Voltage

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Poisson Ratio Specifies the Poisson ratio of the strain gage. Poisson ratio is defined as the negative ratio of the strain
in the transverse direction to the strain in the longitudinal direction.

Excitation Strain bridge conversions require the voltage of the external bridge excitation. For this voltage, you

Fix/ Ext can dedicate a multiplexer channel to measure the excitation voltage, or can specify a known fixed

voltage value. Fixed (Fix) - The fixed value specified by the Excitation Voltage softkey will be used for
the strain conversion. External (Ext) - DCV measurements on the enabled reference channel will be

used for subsequent strain bridge measurements that specify an external excitation voltage source.
Note that the external DCV reference channel must be a lower-numbered channel than the strain

channel.
Excitation Use the knab or the front panel arrow keys to specify the fixed excitation voltage applied to the bridge
Voltage by an external voltage source. This value will be used to convert strain bridge measurements on the

selected channel.

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line
Cycles (PLC). Only 1 PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Delay Done
Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Quarter bridge arrangement

This section describes how to configure the selected channel for quarter bridge strain gage measurements from the
front panel.

1. Connect bridge configuration source to module's screw terminals

R:\R

i 7
[ -

L| @ = R = Strain gage

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

Channel Measure Range Sense Gage More

l Label STRAIN Auto | Settings Settings y 10f2

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is
convenient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range.

—3Select Strain Voltage Rangge ——m—8 —8 88—

Auto | 100mV 100V 300V

4. Press Sense Settings > Sense, specify the strain measurement method as quarter bridge arrangement.

| Quarter

Sense Config
Bridge .3,
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5. Press Gage Settings, and use the knob or the front panel arrow keys to specify various strain gage settings.

- 2.0000

Gage Excitation Excitation Done
Factor Fix Ext sVYoltage

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Excitation Strain bridge conversions require the voltage of the external bridge excitation. For this voltage, you

Fix/ Ext can dedicate a multiplexer channel to measure the excitation voltage, or can specify a known fixed
voltage value. Fixed (Fix) - The fixed value specified by the Excitation Voltage softkey will be used for
the strain conversion. External (Ext) - DCV measurements on the enabled reference channel will be
used for subsequent strain bridge measurements that specify an external excitation voltage source.
Note that the external DCV reference channel must be a lower-numbered channel than the strain

channel.
Excitation Use the knob or the front panel arrow keys to specify the fixed excitation voltage applied to the bridge
Voltage by an external voltage source. This value will be used to convert strain bridge measurements on the

selected channel.

6. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms
of Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC
provide normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and
resolution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.007, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2, 10, 20, 100, and 200 Power Line
Cycles (PLC). Only 1 PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Delay Done
Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Direct resistive method

This section describes how to configure the selected channel for direct 2-wire and 4-wire strain gage measurements
from the front panel. The measurement configurations for 2-wire and 4-wire direct resistive are same, below
descriptions explained by using 2-wire resistance measurements.

1. Connect direct resistive source to the module's screw terminals.

2-wire direct strain:

[o P—
R
L@;%

4-wire direct strain:

H| @ +
Source
Ll @ =
HI @
Sense
L| @

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

AR
Py

Channel Measure Range Sense Gage More

Label STRAIN Auto | Settings | Settings y 1 of 2

3. Press Sense Settings > Sense, specify the strain measurement method as direct 2-wire or 4-wire. Do note that
the Range softkey (as seen in step 2) will no longer be available for configuration once direct 2-wire or 4-wire
method is selected.

Sense 2-Wire Done
Direct 4-Wire
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4. Press Gage Settings, and use the knob or the front panel arrow keys to specify various strain gage settings.

i

Gage Gage
Factor Ohms

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Gage Ohms Gage resistance to be used to convert direct strain measurements on the selected channel.

5. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line
Cycles (PLC). Only 1 PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero OffstComp Delay
Off On Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

OffstComp Offset compensation removes the effects of small DC voltages in the circuit being measured. The technique

Off/ On involves taking the difference between two resistance measurements, one with the current source set to the
normal value, and one with the current source set to a lower value.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,

range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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DC Voltage
This section describes how to configure the selected channel for DC voltage measurements from the front panel.

1. Connect the voltage source to the module's screw terminals.

H @—f\
)V

L@_\/

2. Press[Channel] > Measure, and select DCV from the selection menu.

Channel Measure Range Integrate Advanced
Label DCVY Auto Settings

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto (autor-
ange) automatically selects the range for the measurement based on the input. Autoranging is convenient, but it
results in slower measurements than using a manual range. Autoranging goes up a range at 120% of the
present range, and down a range below 10% of the present range.

Autorange is not supported on the DMM Digitize data acquisition mode.

Select DC Voltage Rangg———m8

Auto 100mV 1V 10V 100V 300V

4. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advanced settings

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Input 2 Delay
Off On 10M Auto Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present an the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

NOTE This setting is available when Scan or DMM Digitize is selected as the

acquisition mode.

Input Z Specifies the measurement terminal input impedance, which is either 10 MQ (10M) or high impedance

10M/ Auto (Auto). The Auto mode selects high impedance (> 10 GQ) for the 100 mV, 1V, and 10V ranges, and 10 MQ
for the 100 V and 300 V ranges. In most situations, 10 MQ is high enough to not load most circuits, but low
enough to make readings suitable for high impedance circuits. It also leads to readings with less naise than
the high impedance option, which is included for situations where the 10 MQ load is significant.

NOTE This setting is available when Scan or DMM Digitize is selected as the

acquisition mode.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement functian,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.

NOTE This setting is only available when Scan is selected as the acquisition mode.
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AC Voltage

The AC Voltage measurement option will only be available when Scan is selected as the acquisition mode.

This section describes how to configure the selected channel for AC voltage measurements from the front panel.

1. Connectthe AC voltage source to the module's screw terminals.

+
H| @ P
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2. Press[Channel] > Measure, and select ACV from the selection menu.

Channel Measure Range Advanced

Label ACY Auto |

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is con-
venient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range.

(———Select AC Voltage Range——m8 ———

100mV 10V 100V 300V
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Advanced settings

Press Advanced to configure the advanced settings for the measurement.

AC Filter Delay
>20Hz Auto Time
Softkey Description
AC Filter Specifies which AC filter to use. The instrument uses three different AC filters that enable you either to

optimize low frequency accuracy or achieve faster AC settling following a change in input signal amplitude.
The three filters are 3 Hz, 20 Hz, and 200 Hz, and you should generally select the highest frequency filter
whose frequency is less than that of the signal you are measuring, because higher frequency filters result in
faster measurements. For example, when you are measuring a signal between 20 and 200 Hz, you should
use the 20 Hz filter. If measurement speed is not an issue, choosing a lower frequency filter may resultin
quieter measurements, depending on the signal that you are measuring.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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DC Current

DC Current measurement is supported only on DAQM901A's channels 21 and 22.

This section describes how to configure the selected channel for DC current measurements from the front panel.

1. Connect DC current source to the module's screw terminals.

Xk %
Amp[L @ J

2. Press[Channel] > Measure, and select DCI from the selection menu.

Channel Measure Range Integrate Advanced
Label DCI Auto Settings

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is
convenient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range. The Auto option is not available
in DMM Digitize data acquisition mode.

——DC Current Range—————8

More

Auto TpA 10pa 100pA TmA 10f 2

4. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms of
Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC provide
normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and res-
olution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.001, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2,10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.
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Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero Delay Done
Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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AC Current
The AC Current measurement option will only be available when Scan is selected as the acquisition mode.
AC Current measurement is supported only on DAQM901A's channels 21 and 22.

This section describes how to configure the selected channel for AC current measurements from the front panel.

1. Connecta current source to the module's screw terminals.

il -
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2. Press[Channel] > Measure, and select ACI from the selection menu.

Channel Measure Range Advanced

| Label ACl Auto [

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(autorange) automatically selects the range for the measurement based on the input. Autoranging is
convenient, but it results in slower measurements than using a manual range. Autoranging goes up a range at
120% of the present range, and down a range below 10% of the present range.

———————— AC Current Range — —8

TmA 10maA 100mA
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Advanced settings

Press Advanced to configure the advanced settings for the measurement.

AC Filter Delay
»>20Hz Auto Time
Softkey Description
AC Filter Specifies which AC filter to use. The instrument uses three different AC filters that enable you either to

optimize low frequency accuracy or achieve faster AC settling following a change in input signal amplitude.
The three filters are 3 Hz, 20 Hz, and 200 Hz, and you should generally select the highest frequency filter
whose frequency is less than that of the signal you are measuring, because higher frequency filters result in
faster measurements. For example, when you are measuring a signal between 20 and 200 Hz, you should
use the 20 Hzfilter. If measurement speed is not an issue, choosing a lower frequency filter may resultin
quieter measurements, depending on the signal that you are measuring.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Resistance

This section describes how to configure the selected channel for 2-wire and 4-wire measurements from the front
panel. The measurement configurations for 2-wire and 4-wire resistance are same, below descriptions explained by
using 2-wire resistance measurements.

1. Connect resistance source to the module's screw terminals.

2-wire ohms:

4-wire ohms:
—~ +
H| @
Source
L] @
l :
! ! SR
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Sense
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2. Press[Channel] > Measure, and select OHMS or OHMS 4W from the selection menu.

Channel Measure Range Integrate Advanced

| Label OHMS Auto  Settings |

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto
(only available when Scan is selected as the data acquisition mode) automatically selects the range for the
measurement based on the input. Autoranging is convenient, but it results in slower measurements than using a
manual range. Autoranging goes up a range at 120% of the present range, and down a range below 10% of the
present range. The Auto option is not available in DMM Digitize data acquisition mode.

(———Select Ohms Range —— 8 ———

1000 1kQ 10k 100kQ2 More
(~1TmA) (~1mA) (~100pA) (~10pA) y) 1of2
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4. Press Integrate Settings softkey to select whether the measurement integration time will be specified in terms
of Number of Power Line Cycles (NPLC) or directly in seconds (Time). Only 1, 2, 10, 20, 100, and 200 PLC
provide normal mode (line frequency noise) rejection. Selecting 200 PLC provides the best noise rejection and
resolution, but the slowest measurements.

Softkey Description

Integrate NPLC Sets the integration time as 0.007, 0.002, 0.006, 0.02, 0.06, 0.2, 1, 2, 10, 20, 100, and 200 Power Line
Cycles (PLC). Only T PLC and longer times provide normal mode (line frequency noise) rejection.
Selecting 100 or 200 PLC provides the best noise rejection and resolution.

Time Directly sets the integration time in seconds.

Advanced settings

NOTE In DMM Digitize data acquisition mode, only the Auto Zero setting will be available in the Advanced settings.

Press Advanced to configure the advanced settings for the measurement.

Auto Zero OffstComp Low Power Delay
Off On Off On Off On Auto Time
Softkey Description
Auto Zero Auto Zero provides the most accurate measurements, but requires additional measurement time to perform
Off/ On the zero measurement. With auto zero enabled (On), the instrument internally measures the offset following

each measurement. It then subtracts that measurement from the preceding reading. This prevents offset
voltages present on the instrument’s input circuitry from affecting measurement accuracy. With auto zero
disabled (Off), the instrument measures the offset once and subtracts the offset from all subsequent
measurements. The instrument takes a new offset measurement each time you change the function, range,
or integration time. (There is no auto zero setting for 4-wire measurements).

OffstCmp Offset compensation removes the effects of small DC voltages in the circuit being measured. The technique

Off/ On involves taking the difference between two resistance measurements, one with the current source set to the
normal value, and one with the current source set to a lower value.

Low Power Selects the low-power resistance measurement. This sources less current resulting in lower power

Off/ On dissipation, and less self-heating, in the resistance under test. Typically, this is about 1/10th the current

sourced for the standard resistance measurements. The approximate current sourced for each
measurement range is shown at the bottom of the resistance range softkeys, for example: (~ 1 mA).

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By

Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,
range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Frequency and Period

The Frequency and Period measurement option will only be available when Scan is selected as the acquisition
mode.

This section describes how to configure the selected channel for frequency and period measurements from the front
panel.

1. Connectan AC source to the module's screw terminals.

-+
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2. Press[Channel] > Measure, and select FREQ or PERIOD from the selection menu.

Channel Measure Range Gate Time Advanced

| Label FREQ Auto 100ms |

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto (autor-
ange) automatically selects the range for the measurement based on the input. Autoranging is convenient, but it
results in slower measurements than using a manual range. Autoranging goes up a range at 120% of the
present range, and down a range below 10% of the present range.

——— Select Frequency Voltage Range ———

100mV 10V 100V 300V

4. Press Gate Time to specify the measurement's aperture (integration time) as 1 ms, 10 ms, 100 ms, or 1 s.

—— Select Gate Time ———
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Advanced settings

Press Advanced to configure the advanced settings for the measurement.

AC Filter Delay
>20Hz Auto Time
Softkey Description
AC Filter Specifies which AC filter to use. The instrument uses three different AC filters that enable you either to optimize low

frequency accuracy or achieve faster AC settling following a change in input signal amplitude. The three filters are 3
Hz, 20 Hz, and 200 Hz, and you should generally select the highest frequency filter whose frequency is less than
that of the signal you are measuring, because higher frequency filters result in faster measurements. For example,
when you are measuring a signal between 20 and 200 Hz, you should use the 20 Hz filter. If measurement speed is
not an issue, choosing a lower frequency filter may result in quieter measurements, depending on the signal that
you are measuring.

Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By selecting

Auto/ Time Auto, instrument will automatically determine the channel delay based on measurement function, range, integration
time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is inserted between the relay clos-
ure and the actual measurement on each channel, in addition to any delay that will implicitly occur due to relay set-
tling time.
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Diode

NOTE The Diode measurement option will only be available when Scan is selected as the acquisition mode.

This section describes how to configure the selected channel for diode test from the front panel.

1. Connect diode source to the module's screw terminals.
+
L| @ =

2. Press[Channel] > Measure, and select DIODE from the selection menu.

Channel Measure Advanced

Label DIODE

Advanced settings
Press Advanced to configure the advanced settings for the measurement.

Delay Done
Auto Time

Softkey Description
Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By
Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,

range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is inser-
ted between the relay closure and the actual measurement on each channel, in addition to any delay that
will implicitly occur due to relay settling time.
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Capacitance

The Capacitance measurement option will only be available when Scan is selected as the acquisition mode.

This section describes how to configure the selected channel for capacitance measurements from the front panel.

1. Connect capacitance source to the module's screw terminals.

+
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2. Press[Channel] > Measure, and select CAP from the selection menu.

Channel Measure Range Advanced
Label CAP Auto

3. Press Range and use the knob or the front panel arrow keys to specify the measurement range. Auto (autor-
ange) automatically selects the range for the measurement based on the input. Autoranging is convenient, but
it results in slower measurements than using a manual range. Autoranging goes up a range at 120% of the
present range, and down a range below 10% of the present range.

—— Capacitance Rangg ——8

More

1nF 10nF 100nF 1uF 10f2

Advanced settings

Press Advanced to configure the advanced settings for the measurement.

Delay Done
Auto Time
Softkey Description
Delay Selects whether the delay between channels in the scan list will be automatically or manually selected. By
Auto/ Time selecting Auto, instrument will automatically determine the channel delay based on measurement function,

range, integration time, and AC filter setting. By selecting Time, the specified delay (time in seconds) is
inserted between the relay closure and the actual measurement on each channel, in addition to any delay
that will implicitly occur due to relay settling time.
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Multiplexer modules: Switch mode

The multiplexer modules (DAQM900A, DAQM90TA, DAQM902A, and DAQM908A) are also able to operate in switch
mode which enables you to open and close channels independently. The section below will describe the steps to
enable and configure the switch mode.

1. Pressthe [Channel] key to access the Channel menu. In the example below, Channel 107 of a DAQM90TA
module in slot 1, labeled as OVEN is set up to measure temperature in degrees °C using a type J thermocouple.

Channel

101 OVEN

MEASURE SETTING ADVANCED

Function: Temp Aperture: 1 PLC Autozero: On
Probe: Thermocouple  Type: J Ref: Internal

Open Check: Off
Delay: Auto

Channel Menu

Channel Measure  Sensor Units Integrate Advanced
 Label TEMP ]_Settings °o¢ °F K JISettings

v

2. Pressthe [Module] key to go to the Module menu. Next, press the Scan List softkey.

Module
Slot 1 20 Channel Arm Mux  rw: DAGM301A,0,01.02

Shunts:

Dttt
Input

DM 1 = @1 Common
CurrentL = _ 2L Current
g6

Module Menu
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3. You would notice that Channel 101 label is OVEN and the Scan Status is ON. Press the Remove from Scan
softkey and you will be prompted to confirm your action. Press the Yes softkey to confirm removing all channels
on the module from the scan list. This action turns off the measurements for the channels on the module and
places the module in switch mode.

Scan Status

Channel Scan Status
101 OVEN ON
102 Armature re ¥ Channel OFF
103 Armature re AUX Channel OFF
104 Armature re UK Channel OFF
105 Armature VILX Channel OFF
106 Armature VUK Channel OFF
107 Armature relay MUX Channe OFF
| 108 Armature relay hanne OFF

Current Page: 1/3

Remove Done
From Scan

Do you want to remove all channels on module
from scan list?
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4. Pressthe [Channel] key to return to the Channel menu. Notice the Open and Close softkeys are now available

since the module is now in switch mode. The channel label is maintained. You can press the Close softkey to
change the channel state.

101 OVEN

MEASURE SETTING ADVANCED
Function: Off

h: Closed
- Joined

Channel Menu

Channel Measure 0 cl Advanced
; Label 0ff pen ose

5. To return to scan mode, press the Measure softkey and select a measurement mode. In the example below,

TEMP is selected and the module is now back in scan mode. The temperature measurement is restored and the
Open and Close softkey are no longer available.

Channel

101 OVEN

MEASURE SETTING ADVANCED

Function: Temp Aperture: 1 PLC Autozero: On
0 hermocouple Type: J Ref: Internal
Open Check: Off
Delay: Auto

Channel Menu

Channel Measure  Sensor Units Integrate Advanced
 Label TEMP ]_Settings o€ °F K JISettings

v
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DAQM907A - Multifunction Module

The following section describes how you may configure each of the channels on the DAQM907A. There are total 7
channels available in the DAQM907A multifunction module as shown in the table below:

01 8-bit Digital /0 Channel
02 8-bit Digital /0 Channel
03 Totalizer Channel

04 DAC Output Channel

05 DAC Output Channel

06 DAC Output Sense Channel
07 DAC Output Sense Channel

Digital I/0 (DIO) Channels (Channel 01 and 02)

The DAQMI07A multifunction module has two non-isolated 8-bit input/output ports which you can use for reading
digital patterns. You can read the live status of the bits on the port or you can configure a scan to include a digital
read.

Configure the DIO channel

1. Press [Module] and use the knob or the front panel arrow keys to select the slot containing the multifunction
module.

Module

Slot 2 Multifunction FW: DAGMOID7A,0,00.77

@ + Input Cebvibd
@ - Input |"'E'_-'t

T
;:1

Card Module
Reset i1 Lahel
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2. Press[Channel] and use the knob or the front panel arrow keys to select the DIO channels (channel 01 and 02).

Channel | #
301 8-bit Digital |70 Channel

OPERATION SETTING

Last Value Read: 11111111hb In Scan: Off
0xFFh Direction: Input

255d

Channel  In Scan Read
| Label  off On
3. PressIn Scan to specify whether to include (On) or exclude (Off) the DIO channel from the scan list.

Channel Menu

Channel In Scan Read
 Label  off on =

Read Press the Read softkey to read the bit patterns directly from a digital input port.
Write Press the Write softkey to specify and output the bit pattern to the specified port.

Read a digital input port

Press theRead softkey to define the DIO direction as Input.

Channel Menu

Channel In Scan Read
, Label — 0ff On
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Write to a digital input

1. Press [Module] and use the knob or the front panel arrow keys to select the slot containing the multifunction
module.

Module |

Slot 2 Multifunction FW: DAQMS074,0,00.77

Diiy
Current

Card Module
Reset | Label

2. Press[Channel] and use the knob or the front panel arrow keys to select the DIO channels (channel 01 and 02).

Channel | ®
301 8-bit Digital /0 Channel

OPERATION SETTING
Last Yalue Read: 11111111b In Scan: Off
0xFFh Direction: Input
256d

lfi hannel Menu

Channel In Scan Read
 Label  off on m
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3. Press Write > Base and use the knob or the front panel arrow keys to select the number base used (Hex, Binary,
or Decimal), and then press Pattern to define each output pattern from the selected base.

Channel Menu

Channel In Scan Read
, Label  off oOn o

,—_Select Base ———

Binary Decimal

BT

1

Base Pattern Write Done
Hex 2 Pattern Clear p

4. Press Write Pattern to output the bit pattern on the selected digital output port. The DIO direction will be set to
Output.

[ o

I

Base Pattern Write Done
Hex 3 | Pattern Clear A

g

5. Press Clear to set the output pattern to "0".

TR

Base ; Pattern Write Done
Hex & Pattern Clear y
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Totalizer Channel

The DAQMY07A multifunction module has a 26-bit totalizer which can count TTL-compatible pulses at a 100 kHz
rate. The totalizer channel is numbered "s03", where "s" represents the slot number. The totalizer channel is labeled
as channel 03.

You can manually read the totalizer count or you can configure a scan to read the count.
To configure the totalizer channel with the multifunction module:

1. Press [Module] and use the knob or the front panel arrow keys to select the slot which containing the
DAQOMI07A multifunction module.

Module

Slot 2 Multifunction FW: DAOMS07A,0,00.77

Output

@ + Input DM
@ - InpLt

Current

Card Module
Reset J Label
2. Press[Channel] and use the knob or the front panel arrow keys to select the totalizer channel (channel 03).

Channel | __
203 Totalizer Channel
OPERATION_ SETTING

Last Value Read: ssessees

Channel Menu

Channel In Scan TR Clear Start Settings
, Label  0ff On Count Stop |
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3. Press In Scan to specify whether to include (On) or exclude (Off) the totalizer channel from the scan list.

Channel Menu

Channel In Scan Read Clear Start Settings
, Label  off on el Count Stop |

4. Press Settings > Edge to specify if the totalizer channel should count on the rising edge (Pos) or falling edge
(Neg) if the input signal, and then press ReadReset to specify if the totalizer count should be automatically reset
(On) or not (Off) when read.

Edge  ReadReset Done
Pos Neg Off On p

5. Press Read to read the totalizer count. The count is read once each time you press Read; the count does not
update automatically on the display.

Channel Menu

Channel In Scan Read Clear Start Settings
, Label  0ff On e Count Stop |

6. Press Clear Count to reset the totalizer count to "0".

7. Press the Start/Stop softkey to toggle between Start to start the counting on the current totalizer channel, or
Stop to stop the counting on the current totalizer channel.
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DAC output and sense channels (Channels 04 through 07)

The DAQM907A multifunction module has two DAC output channels (channel 04 and 05), and two DAC output
sense channels (channel 06 and 07). Any of these channels may be scanned.

For the DAC output channels, no actual output measurement is made; the scanned value will be the programmed
output value (voltage or current).

The DAC output sense channels will make a complementary (voltage or current) measurement based on the output
mode of the corresponding DAC output channel:

= Channel 06 will make the measurement based on the output mode set in channel O4.
= Channel 07 will make the measurement based on the output mode set in channel 05.

If DAC output channel 04 is set to voltage mode, then the corresponding DAC sense channel 06 will measure
current. If the output channel is set to current mode, the sense channel will measure voltage.

1. Press [Module] and use the knob or the front panel arrow keys to select the slot containing the multifunction
module.

Module

Slot 2 Multifunction Fw: DAQMI074,0,00.77

@ + [nput Dbt
2 — Input Input

Module Menu

Card Module
Reset J Lahel
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2. Press[Channel] and use the knob or the front panel arrow keys to select the DAC output channels (channel 04
and 05) or the DAC sense channels (channel 06 and 07).

Channel | ™
305 DAC Output Channel

OPERATION SETTING

Output: 0.000 00 A In Scan: Off
Sourcing: Current
Lock: Off

Channel Menu

Channel In Scan Sourcing Lock Write
, Label  Off On Current Off On

Channel | ™
307 DAC Output Sense Channel

IM_EASL_'RE SETTING
Sense Paired Channel: 305 In Scan: Off

Sense Type: Current Delay: Auto

Channel Menu

Channel In Scan Settings
| Label  off On

3. Press In Scan to specify whether to include (On) or exclude (Off) the DAC channel from the scan list.
4. Press Sourcing to set the output mode in the DAC output channel to Voltage or Current.

5. Toggle Lock (On) to lock the DAC output channel mode or toggle Lock (Off) to disable the lock on the DAC out-
put channel mode.

6. Press Write > Output to set the output voltage/current level, and then press Write Output to output the voltage/-
current from the selected DAC output channel.

Keysight DAQ970A/DAQ973A User's Guide 141



3 Features and Functions

DAQ@MI09A - 4 Channel 24-Bit Digitizer Module

The DAQMO909A can be configured to digitize DC Voltage (DCV) and Strain. The following section describes how you
may configure the channels on the DAQM909A.

DC Voltage (DCV)

This section describes how to configure the channels on DAQM909A for DC voltage measurement from the front
panel.

1. Connect the voltage source to the module's screw terminals.

+
H| @
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2. Press[Channel] > Measure, and select DCV from the selection menu

Channel

201 Digitizer Channel

MEASURE SETTING ADVANCED

Function: DC Volts Filter Mode: Time
Range: 1V Coupling: DG

Input Type: Diff
Power

Channel Menu

Channel Measure WVolt Range Advanced
Label DCV 1V ]

3. Press the Volt Range softkey to specify the DC voltage measurement range. You may choose between 300mV, 1
V (default value), 3V,or 18V.

300mV ‘ v ‘ 3V 18V
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Advance Settings

Press Advanced to configure the advanced settings for the digitizer.

Mode Coupling Type Puwsr. Alys Done
Time Freq AC DC Diff On Off
Softkey Description
Mode Determines the ADC filter mode. Press the Mode softkey to toggle between setting the input in time domain
Time/ Freg mode (Time) or setting the input in frequency domain mode (Freq). When Time mode is selected, the on

board ADC is configured to use the Sincb filter. When Freq mode is selected, the onboard ADC is configured
to use the Wideband filter.

Coupling Press the Coupling softkey to toggle between how the graph is displayed, in AC or DC mode. In AC mode,
AC/DC the AC coupling will display the DC signal that is normalized to a mean of zero. In DC mode, the DC
coupling will display the original signal on the screen.

Type Diff Differential (Diff) input measures the input signals from high and low input terminals.

Send Single Ended (Send) input measures the input signals from high input terminal and grounded low input

terminal.
lepe Integrated Electronics Piezo Electric (lepe) transducer (2-wire IEPE with 100 Ohm LO Ground) measures the
input signals with direct current supplied to the high and low input terminals.
Pwr. Alys Press the Pwr, Alys softkey to toggle between enabling (On) or disabling (Off) the power analysis feature on
On/ Off the specified channel during data post processing in the View menu.

NOTE See Power Analysis for further details
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Strain

This section describes how to configure the channels on DAQM909A for strain measurement from the front panel.

1. Connect your desired bridge configuration source to the module's screw terminals.

Full bending bridge:

ul o + Strain gage _7A i Strain gage
N4

Strain gage —\/— Strain gage

}|

Strain gage

kx
NA

Strain gage

m>—|
‘o

,_
&:.
I
!
\{7\

Strain gage

2. Press[Channel] > Measure, and select STRAIN from the selection menu.

Channel Menu

Channel Measure Volt Range Settings Advanced
Label STRAIN 11

3. Press the Volt Range softkey to specify the DC voltage measurement range. You may choose between 300mV, 1
V (default value), 3 V,or 18V.

300mV v ‘ 3V
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4. Press Settings > Sense Settings softkey to specify the strain measurement method based on the bridge con-
figuration which was setup in step 1.

Sense Gage
Settings | Settings

5. Press the Gage Settings softkey to specify the various strain gage settings.

Sense Gage Done
Settings | Settings

Poisson Excitation Done
] VYoltage

Softkey Description

Gage Factor Gage factor is the ratio of the fractional change in resistance to the fractional change in length (strain)
along the axis of the gage. The larger the value, the more sensitive strain gage. Gage factor is a
dimensionless quantity. The typical value is approximately 2.

Poisson Ratio Specifies the Poisson ratio of the strain gage. Poissan ratio is defined as the negative ratio of the strain
in the transverse direction to the strain in the longitudinal direction.

The Poisson Ratio softkey will only be available when Poisson is specified as
the type in the Sense menu.

Excitation Use the knab or the front panel arrow keys to specify the fixed excitation voltage applied to the bridge
Voltage by an external voltage source. This value will be used to convert strain bridge measurements on the
selected channel.
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Advance Settings

Press Advanced to configure the advanced settings for the digitizer.

Mode Coupling Type

Time Freq AC DC Diff
Softkey Description

Mode Determines the ADC filter mode. Press the Mode softkey to toggle between setting the input in time domain
Time/ Freq mode (Time) or setting the input in frequency domain mode (Freq). When Time mode is selected, the on

board ADC is configured to use the Sinc5 filter. When Freq mode is selected, the onboard ADC is con-
figured to use the Wideband filter.

Coupling Press the Coupling softkey to toggle between how the graph is displayed, in AC or DC mode. In AC mode,
AC/DC the AC coupling will display the DC signal that is normalized to a mean of zero. In DC mode, the DC
coupling will display the original signal on the screen.
Type Diff Differential (Diff) input measures the input signals from high and low input terminals.
Send Single Ended (Send) input measures the input signals from high input terminal and grounded low input
terminal.
lepe Integrated Electronics Piezo Electric (lepe) transducer (2-wire [EPE with 100 Ohm LO Ground) measures

the input signals with direct current supplied to the high and low input terminals
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Computed Channel

A computed channel performs mathematical operations on the readings from measurement channels, or other
computed channels. To configure, press Channel and use the knob or right arrow key to select one of the computed
channels (channels 401 through 420).

You must configure the measurement channel(s) before performing the mathematical operations in the
computed channel.

Monitoring of computed channels is only available during scanning and will only display the reading from the
most recent sweep.

The computed channel is not available when DMM Digitize, or Digitizer is selected as the data acquisition
mode.

Channel | i
401 Computed Channel

OPERATION SETTING

Equation: & + B In Scan: Off
Channel 4: 101
Channel B: 101

Channel Menu

Channel In Scan TEL
| Label — off on I

.

Press In Scan to specify whether the computed channel is included in (On) or excluded from (Off) the scan list. Press
Equation to specify the equation to be used for the computed channel. The equations choices can be categorized in
three main groups: Basic math, polynomial fifth order, and statistics.
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Basic math

Table below shows the supported basic mathematical operations with the respective softkey label.

Addition A+B
Subtraction A-B
Multiplication A*B
Division A/B
Reciprocal 1/A
Power A2
Square root Sqrt(A)

For example, to perform the Addition operation from measurement channels (channel 101 and 102) to the computed